
  

 

 

МИНИСТЕРСТВО ОБРАЗОВАНИЯ И НАУКИ УКРАИНЫ 

ЧЕРНИГОВСКИЙ ГОСУДАРСТВЕННЫЙ ТЕХНОЛОГИЧЕСКИЙ УНИВЕРСИТЕТ 

 

 

 

 

 

 

 

 

 

 

 

ПРОЕКТИРОВАНИЕ НА VHDL В САПР QUARTUS II 
 

МЕТОДИЧЕСКИЕ УКАЗАНИЯ 
к самостоятельной работе и к выполнению расчѐтно-графической работы 

по дисциплине “Технологии проектирования компьютерных систем” 

для студентов направления подготовки 

6.050102 – “Компьютерная инженерия” 

 

 

 

 

 

 

Обсуждено и рекомендовано 

на заседании кафедры 

информационных и компьютерных систем 

Протокол № __ 

от __.__.2013 г. 

 

 

 

 

 

 

 

 

Чернигов ЧГТУ 2013 



 

 

Проектування на VHDL в САПР QUARTUS II. Методичні вказівки до са-

мостійної роботи та до виконання розрахунково-графічної роботи з дисципліни 

"Технології проектування комп'ютерних систем" для студентів напряму підго-

товки 6.050102 – "Комп'ютерна інженерія"/ Укл.: Вервейко О.І., 

Красножон О.В. – Чернігів: ЧДТУ, 2013. – 71 с. Рос. мовою. 

 

 

 

Составители: ВЕРВЕЙКО АЛЕКСАНДР ИВАНОВИЧ, кандидат технических наук,  

доцент, доцент кафедры информационных и компьютерных си-

стем 

КРАСНОЖОН АЛЕКСЕЙ ВАСИЛЬЕВИЧ, ассистент кафедры информа-

ционных и компьютерных систем 

 

 

 

 

Ответственный за выпуск: КАЗИМИР ВЛАДИМИР ВИКТОРОВИЧ, заведующий ка-

федрой информационных и компьютерных систем, 

доктор технических наук, профессор 

 

 

 

 

Рецензент: НЕСТЕРЕНКО СЕРГЕЙ АЛЕКСАНДРОВИЧ, кандидат технических наук, 

доцент кафедры информационных и компьютерных систем Черни-

говского государственного технологического университета 

 



Методические указания 

 3 

СОДЕРЖАНИЕ 

 

ВВЕДЕНИЕ .................................................................................................................. 5 

1 САМОСТОЯТЕЛЬНАЯ РАБОТА .......................................................................... 7 

1.1 Цель и задачи дисциплины ............................................................................... 7 

1.2 Содержание дисциплины ................................................................................. 8 

1.2.1 Введение ................................................................................................... 8 

1.2.2 Методы проектирования цифровых устройств .................................... 8 

1.2.3 История создания языка VHDL .............................................................. 8 

1.2.4 Алфавит языка VHDL и его лексические элементы ............................ 8 

1.2.5 Типы данных ............................................................................................ 9 

1.2.6 Имена ........................................................................................................ 9 

1.2.7 Выражения ................................................................................................ 9 

1.2.8 Представление системы в VHDL ........................................................... 9 

1.2.9 Структурное описание цифровых устройств ........................................ 9 

1.2.10 Функциональное описание цифровых устройств............................... 9 

1.2.11 Особенности описания цифровых автоматов в САПР фирмы 

ALTERA .................................................................................................... 9 

1.3 Распределение объема самостоятельной работы ......................................... 10 

1.4 Экзаменационные вопросы ............................................................................ 10 

2 ОСОБЕННОСТИ ПРИМЕНЕНИЯ VHDL В САПР QUARTUS ........................ 13 

2.1 Параллельное предложение Block Statement ................................................ 13 

2.2 Способы использования компонентов пользователя в САПР Quartus ...... 21 

2.2.1 Описание и декларация компонента в одном VHDL-файле ............. 22 

2.2.2 Описание компонента в отдельном VHDL-файле, расположенном в 

каталоге с проектом ............................................................................... 24 

2.2.3 Описание компонента в отдельном VHDL-файле, расположенном 

вне каталога с проектом ........................................................................ 26 

2.2.4 Описание компонента в пакете, расположенном в каталоге с 

проектом ................................................................................................. 27 

2.2.5 Описание компонента в одном файле с декларацией пакета ............ 29 

2.2.6 Подключение компонента, декларированного в пакете, без 

применения предложения Use Clause .................................................. 31 

2.2.7 Описание пакета, компонента и устройства в одном файле ............. 32 

2.2.8 Подключение компонента из библиотеки ........................................... 33 

2.2.9 Сравнительный анализ способов подключения компонентов .......... 35 

2.3 Предложения Assertion Statement и Report Statement .................................. 36 

2.3.1 Оператор утверждения (Assertion statement) ...................................... 37 

2.3.2 Предложение Report statement .............................................................. 38 

2.3.3 Применение предложений Assertion Statement и Report Statement в 

различных САПР.................................................................................... 38 

3 РАСЧЁТНО-ГРАФИЧЕСКАЯ РАБОТА ............................................................. 41 

3.1 Цель и порядок выполнения расчѐтно-графической работы ...................... 41 

3.2 Требования к отчѐту о выполнении расчѐтно-графической работы .......... 41 



Проектирование на VHDL в САПР Quartus II 

 4 

3.3 Варианты заданий ........................................................................................... 42 

3.4 Пример выполнения расчѐтно-графической работы ................................... 58 

3.4.1 Анализ известных методов построения счѐтчиков ............................ 58 

3.4.2 Описание варианта задания .................................................................. 62 

3.4.3 Разработка схемы алгоритма функционирования синхронного 

реверсивного счѐтчика с параллельным переносом .......................... 63 

3.4.4 Разработка поведенческого описания синхронного реверсивного 

счѐтчика с параллельным переносом на языке VHDL ....................... 65 

3.4.5 Анализ работоспособности синхронного реверсивного счѐтчика с 

параллельным переносом и оценка соответствия заданным 

требованиям ............................................................................................ 67 

3.4.6 Выводы .................................................................................................... 69 

РЕКОМЕНДОВАННАЯ ЛИТЕРАТУРА ................................................................ 71 

 



Методические указания 

 5 

ВВЕДЕНИЕ 

В настоящее время невозможно представить жизнь без вычислительных 

устройств, скрытых в бытовой технике, измерительных и медицинских прибо-

рах и т.п. Если мысленно охватить всю электронную технику, используемую 

человеком, то на один универсальный микропроцессор приходятся многие де-

сятки специализированных вычислительных устройств (ВУ). 

Проектирование ВУ представляет собой поэтапное преобразование тех-

нического описания устройства с уточнением и детализацией на каждом новом 

этапе. Традиционное проектирование ВУ основано на составлении на каждом 

этапе различных графических схем. В соответствии с назначением этапа, раз-

личают схемы алгоритмов, схемы электрические структурные, принципиальные 

и функциональные. Повсеместное внедрение САПР электронных схем обеспе-

чивает уменьшение трудозатрат, повышение качества проектов, но не меняет в 

корне характер проектирования, как ручного описания ВУ. 

Использование при разработке вычислительных устройств таких языков 

проектирования, как VHDL и Verilog позволяет отказаться от составления схем 

на большинстве этапов разработки. 

VHDL (VHSIC (Very high speed integrated circuits) Hardware Description 

Language) – язык описания аппаратуры интегральных схем. Язык проектирова-

ния VHDL является базовым языком при разработке аппаратуры современных 

вычислительных систем. 

Язык VHDL предназначен для решения комплекса задач в ходе проекти-

рования и применения цифровых систем, их аппаратных средств, в том числе: 

 описания структуры системы, декомпозиции системы на подсистемы, 

спецификации связей и взаимодействия подсистем; 

 спецификации функционирования системы, узлов, блоков, реализуемых 

функций. Спецификация дается в алгоритмической форме, с использованием 

привычных для современных специалистов программных конструкций 

алгоритмического языка, включающих в себя спецификацию временного 

поведения сигналов и блоков; 

 моделирования системы и ее работы на основе четкой спецификации 

структуры системы, а также функционирования ее компонентов; 

 синтеза схемотехнической реализации системы, автоматической 

генерации детальной структуры на основе строгой спецификации системы на 

языке VHDL – спецификации на более абстрактном уровне. 

Язык VHDL используют для описания структуры и функционирования 

системы. Такое описание, достаточно формализованное и однозначное, имеет 

уже самостоятельную ценность, как средство передачи знаний о спроектиро-

ванной аппаратно реализованной цифровой системе (устройстве, блоке) от раз-

работчика к специалисту, ее применяющему. 

Язык VHDL – необычный язык как для программиста так и для разработ-

чика аппаратуры. Это связано с тем, что по своей природе VHDL – язык парал-

лельного программирования. Начинающие программисты иногда путаются в 
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основах программирования на VHDL, допускают трудно выявляемые ошибки, а 

их результирующие проекты часто оказываются далеки от оптимальных. 

Для избегания появления таких ошибок разработчики должны заниматься 

изучением возможностей предоставляемых языком VHDL. Знание особенно-

стей языка, существующих в нем возможностей и синтаксических конструкций, 

во многом избавляет разработчика от необходимости описывать действия, уже 

присутствующие в языке, самостоятельно. Это значительно сокращает время 

разработки, уменьшает количество ошибок и позволяет сделать результирую-

щее устройство более оптимальным. 
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1 САМОСТОЯТЕЛЬНАЯ РАБОТА 

1.1 Цель и задачи дисциплины 

Дисциплина "Технологии проектирования компьютерных систем" входит 

в число дисциплин самостоятельного выбора студента цикла подготовки по 

компьютерной схемо- и системотехники профессиональной программы высше-

го образования по направлению 6.050102 – "Компьютерная инженерия" и рас-

сматривается кафедрой как составная часть специальной подготовки в области 

разработки аппаратных средств ЭВМ вместе с дисциплинами "Прикладная тео-

рия цифровых автоматов", "БИС МП и ПЛ", "Периферийные устройства" и 

"Архитектура компьютеров". Необходимыми предпосылками для преподавания 

дисциплины "Технологии проектирования компьютерных систем" является 

усвоение студентами материала дисциплин «Математика», «Физика», «Теория 

электрических цепей", "Компьютерная электроника" и "Компьютерная схемо-

техника" . 

Целью изложения дисциплины "Технологии проектирования компьютер-

ных систем" является формирование у студентов научного уровня инженерного 

мышления будущего специалиста, содержит в себе теоретическую базу, кото-

рая необходима при усвоении прикладных вопросов разработки и эксплуатации 

аппаратных средств ЭВМ, а также компьютерных систем и сетей. После изуче-

ния дисциплины студенты должны иметь знания: 

- о построении, принципах действия, основных параметрах и характери-

стиках сверхбольших интегральных схем программируемой логики (СБИС 

ПЛ); 

- об особенностях построения цифровых устройств на основе (СБИС ПЛ); 

- о современных методах проектирования цифровых устройств; 

- о языках описания аппаратных средств (ЯОА); 

- о методах описания цифровых устройств с использованием МОА; 

- о применении редакторов временных диаграмм и диаграмм состояний 

цифрового автомата для синтеза цифровых устройств; 

- об основных параметрах и характеристиках современных систем авто-

матизированного проектирования (САПР); 

- о методиках практического применения САПР синтеза для цифровых 

устройств различного назначения. 

В результате освоения учебной дисциплиной студенты должны уметь: 

- анализировать параметры и характеристики СБИС ПЛ с целью получе-

ния необходимых параметров и характеристик цифровых устройств; 

- проектировать цифровые устройства с использованием ЯОА и редакто-

ров временных диаграмм и диаграмм состояний цифрового автомата; 

- разрабатывать специализированные устройства на базе СБИС ПЛ; 

- правильного применить СБИС ПЛ в цифровых устройствах и узлах; 

- выполнять математическое моделирование цифровых устройств; 

- экспериментально определять параметры и характеристики цифровых 

устройств. 
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Значение дисциплины для реализации требований квалификационной ха-

рактеристики специалиста и изучение следующих дисциплин заключается в 

том, что дисциплина способствует формированию алгоритмического мышления 

будущего специалиста, создает базу, которая необходима при изучении многих 

последующих дисциплин. 

В связи с интенсивным развитием средств вычислительной техники ос-

новное внимание уделено изучению современных методов проектирования 

цифровых устройств разного назначения на основе СБИС ПЛ, а также приобре-

тению знаний, навыков и практического опыта в проектировании реконфигури-

руемых устройств с применением современных САПР. 

Преподавание дисциплины "Технологии проектирования компьютерных 

систем" обусловлено необходимостью формирования у студентов четкой си-

стемы представлений о целостном комплексе проблем, которые должны быть 

решены в процессе разработки узлов и специализированных устройств ЭВМ. 

Дисциплина является базовой для дисциплин "Архитектура компьюте-

ров", "Проектирование специализированных КС", "Проектирование встроенных 

КС", "Компьютерные системы", "Телекоммуникационные системы и техноло-

гии". 

1.2 Содержание дисциплины 

1.2.1  Введение 

История развития методов проектирования цифровых устройств и ЯОА. 

Предмет и цели курса. 

1.2.2  Методы проектирования цифровых устройств 

Тенденции развития цифровых устройств. Традиционные методы проек-

тирования: проектирование с помощью булевых функций, схемотехническое 

проектирование. Недостатки традиционных методов. Методы разработки: схе-

мотехническое проектирование с использованием САПР, проектирование с по-

мощью языков описания аппаратуры, описание устройства с использованием 

временных диаграмм его работы, применение диаграмм состояний для описа-

ния работы последовательных устройств. Современный цикл проектирования 

цифровых устройств. 

1.2.3  История создания языка VHDL 

Первые языка описания аппаратных средств. Этапы развития языка 

VHDL. Центры поддержки языка VHDL. 

1.2.4  Алфавит языка VHDL и его лексические элементы 

Алфавит языка. Лексические элементы. Разделители и ограничители. 

Идентификаторы. Литералы: перечисление, числа, срочные литералы, битовые 

строки. Комментарии. Ключевые (зарезервированные) слова. 
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1.2.5  Типы данных 

Скалярные типы: перечисление, целые числа, физические типы, числа с 

плавающей точкой. Составные типы: массивы, записи. Указатели. Файлы. 

Функции преобразования типов данных. 

1.2.6  Имена 

Простое имя. Символ оператора. Селективное имя. Индексное имя. Вы-

резка имени. Имя атрибута. Видимость и область действия имен. 

1.2.7  Выражения 

Операторы: логические, сравнения, сложения и конкатенации, присвое-

ния знака, сдвига, умножения и деления, смешанные. 

Операнды: Name, Literal, Аggrеgаtе, Function Call, Qualified Expression, 

Type Conversion, Allocator, статическое выражение, универсальное выражение. 

1.2.8  Представление системы в VHDL 

Общая структура описания проекта системы. Сущность проекта системы. 

Архитектура проекта системы. Предложения VHDL. 

1.2.9  Структурное описание цифровых устройств 

Сигналы в VHDL. Описание нерегулярных структур. Описание регуляр-

ных структур. 

1.2.10  Функциональное описание цифровых устройств 

Описание комбинационных устройств: особенности применения сигна-

лов, параллельные и последовательные предложения, подпрограммы; примеры 

описания шифраторов и умножителей. 

Описание последовательных устройств: триггеров, регистров, счетчиков, 

цифровых автоматов, запоминающих устройств. 

Применение типа данных RECORD при описании цифровых устройств. 

1.2.11  Особенности описания цифровых автоматов в САПР фирмы 

ALTERA 

Основные положения разработки проекта в редакторах временных диа-

грамм и диаграмм состояний. Правила создания комбинационных и последова-

тельных устройств: триггеров, регистров, цифровых автоматов. Примеры опи-

сания цифровых устройств. 
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1.3 Распределение объема самостоятельной работы 

Распределение объема самостоятельной работы указано в таблице 1.1. 

Таблица 1.1 – Распределение объема самостоятельной работы по видам работ 

Вид работы Объем, часов 

1 Усвоение лекционного материала 6 

2 Подготовка к лабораторным работам 4 

3 Подготовка отчетов по лабораторным работам 4 

4 Работа с методическими материалами, основной и 

вспомогательной литературой 
3 

5.Самостоятельное изучение на основе учебной литера-

туры следующих вопросов: 

1 Особенности проектирования цифровых устройств в 

САПР QUARTUS; 

2 Методики определения временных параметров циф-

ровых устройств 

8 

6 Выполнение расчетно-графической работы 8 

Всего за курс 33 

1.4 Экзаменационные вопросы  

1 Тенденции развития цифровых устройств. 

2 Способы создания быстродействующих устройств. 

3 Традиционные методы проектирования цифровых устройств. 

4 Новые методы проектирования цифровых устройств. 

5 История создания языка VHDL. 

6 Алфавит языка VHDL. 

7 Лексические элементы. 

8 Типы данных языка VHDL. 

9 Скалярные типы. 

10 Составные типы данных языка VHDL. 

11 Array_type_definition (массивы) языка VHDL. 

12 Record_type_definition (записи) языка VHDL. 

13 Функции преобразования типов данных. 

14 Формы имен языка VHDL. 

15 Выражения языка VHDL. 

16 Операторы языка VHDL.  

17 Операнды языка VHDL. 

18 Общая структура описания проекта системы. 

19 Сущность проекта системы. 

20 Параметры настройки системы (Generic) сущности проекта. 

21 Порты связи (Port) сущности проекта системы. 

22 Архитектура проекта системы. 

23 Предложения языка VHDL. 
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24 Предопределенные атрибуты языка VHDL. 

25 Атрибуты для скалярных типов данных и сигналов. 

26 Атрибуты для массивов и сигналов. 

27 Особенности структурного описания цифровых устройств. 

28 Предложение Cоmроnеnt Dеclаrаtiоn. 

29 Сигналы в VHDL. 

30 Декларация сигналов в VHDL. 

31 Предложение Component Instantiation Statement. 

32 Описание нерегулярных структур на примитивах. 

33 Описание нерегулярных структур на макрофункциях. 

34 Описание нерегулярных структур на компонентах пользователя. 

35 Описание нерегулярных структур на параметризированных модулях с 

применением 2D массивов. 

36 Описание регулярных структур. 

37 Декларация конфигурации. 

38 Конфигурируемая архитектура компонента. 

39 Конфигурация компонентов в проекте. 

40 Конфигурация компонента и его имен портов. 

41 Configuration specification. 

42 Спецификация архитектуры компонента. 

43 Спецификация компонента и его имен портов. 

44 Описание комбинационных устройств. 

45 Типы Concurrent Signal Assignment Statements. 

46 Conditional Signal Аssignmеnt Statement. 

47 Selected Signal Assignment. 

48 Описание комбинационных устройств с применением 2D массивов. 

49 Process Statement. 

50 Особенности применения сигналов. 

51 Variable Declaration Statement и Variable Assignment Statement. 

52 Различия между переменными и сигналами. 

53 Особенности применения сигналов и переменных. 

54 Формы подпрограмм. 

55 Процедуры. 

56 Функции. 

57 Функции вида Риrе и Impure. 

58 Виды последовательных предложений. 

59 Предложение If Statement. 

60 Предложение Cаsе Stаtеmеnt. 

61 Предложение Lоор Statement. 

62 Предложение Lоор Statement с итерационной схемой While. Фрагмент 

программы. 

63 Предложение Lоор Statement с предложением Next Statement. Фрагмент 

программы. 

64 Предложение Lоор Statement с предложением Exit Statement . Фрагмент 

программы. 
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65 Предложение Return Statement. Фрагмент программы. 

66 Предложение Assertion Statement. Фрагмент программы. 

67 Предложение Report statement. Фрагмент программы. 

68 Формы предложения Wait Statement. 

69 Предложение Wait Statement. 

70 Цифровые автоматы. 

71 Описание цифрового автомата с автоматической кодировкой состояний. 

72 Описание цифрового автомата с кодировкой состояний, задаваемых 

пользователем. 

73 Описание цифрового автомата с применением его диаграммы состояний. 

74 Описание цифрового автомата с применением его таблицы состояний. 

75 Общие правила создания цифровых устройств с использованием времен-

ных диаграмм их работы. 

76 Правила создания комбинационных устройств с использованием времен-

ных диаграмм их работы. 

77 Правила создания регистров с использованием временных диаграмм их 

работы. 

78 Правила создания цифровых автоматов с использованием временных 

диаграмм их работы. 

79 Описание последовательных устройств. 

80 Особенности описания D-триггеров. 

81 Особенности описания JK-регистров. 

82 Особенности описания параллельных счетчиков. 

83 Особенности описания последовательных счетчиков. 

84 Описание синхронных ОЗУ с помощью параметризированных модулей. 

85 Описание асинхронных ОЗУ с помощью параметризированных модулей. 

86 Модуль EAB микросхемы FLEX10K фирмы Altera. 

87 Применение типа данных RECORD при описании цифровых устройств. 

88 Поведенческое описание ОЗУ. 

89 Поведенческое описание последовательных ПЗУ. 

90 Поведенческое описание параллельных ПЗУ. 
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2 ОСОБЕННОСТИ ПРИМЕНЕНИЯ VHDL В САПР QUARTUS 

2.1 Параллельное предложение Block Statement 

Параллельное предложение Block Statement предназначено для иерархи-

ческой декомпозиции программы на языке VHDL, для управления областью 

действия описаний переменных, процедур. 

Синтаксис предложения Block Statement имеет вид: 

block_statement ::= 

block_label : 

block [ ( guard_expression ) ] [ is ] 

block_header 

block_declarative_part 

begin 

block_statement_part 

end block [ block_label ] ; 

 

block_header ::= 

[ generic_clause 

[ generic_map_aspect ; ] ] 

[ port_clause 

[ port_map_aspect ; ] ] 

 

block_declarative_part ::= 

{ block_declarative_item } 

 

block_statement_part ::= 

{ concurrent_statement } 

Сторожевое выражение (guarded_expression) – выражение булевского ти-

па, которое служит для определения значения описанного внутри блока сигна-

ла, называемого сторожем (quard). Если изменяет свое значение один из сигна-

лов, входящих в состав сторожевого выражения, то значение сигнала quard не-

медленно пересчитывается. Использование механизма сторожевых выражений 

позволяет сгруппировать внутри блока операторы присваивания, для которых 

условие выполнения включает в себя общий компонент. 

Рассмотрим в качестве примера описание D-триггера с помощью блоков. 

 

LIBRARY ieee; 

USE ieee.std_logic_1164.all; 

ENTITY vdff1 IS 

 PORT (D, clk : IN std_logic; 

    Q, Q1, Q2 : OUT std_logic); 

END ENTITY vdff1; 

ARCHITECTURE behav OF vdff1 IS 
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       BEGIN 

 blck: BLOCK (clk = '1') IS 

      BEGIN 

  Q <= GUARDED D; 

 END BLOCK; 

blck1: BLOCK (rising_edge(clk)) IS 

       BEGIN 

  Q1 <= GUARDED D; 

  Q2 <= D; 

 END BLOCK; 

END ARCHITECTURE behav; 

 

Временные диаграммы приведены на рисунке 2.1. 

 

 
 

Рисунок 2.1 – Временные диаграммы работы цифровых устройств, 

описанных предложением Block Statement 

Из анализа временных диаграмм следует, что в первом случае синтезиро-

ван статический триггер, во – втором . динамический, в третьем – буфер. 

Параллельные предложения присваивания сторожевого сигнала может 

быть двух типов: 

– Conditional Signаl Assignment Statement; 

– Selected Signal Assignment. 

Conditional Signаl Assignment Statement имеет формат: 

__lаbеl: 

__signаl <= [ guarded] 

__еxрrеssiоn WHEN __bооlеаn_еxрrеssiоn ELSE 

                  __еxрrеssiоn WHЕN __bооlеаn_еxрrеssiоn ЕLSЕ 

                   __еxрrеssiоn; 

Selected Signal Assignment имеет формат: 

__label: 

WITH __еxрrеssiоn SELECT 

  __signаl <= [guarded] 

__еxрrеssiоn WHЕN __cоnstаnt_vаluе, 

    __еxрrеssiоn WHЕN __cоnstаnt_vаluе, 



Методические указания 

 15 

    __еxрrеssiоn WHЕN __cоnstаnt_vаluе, 

    __еxрrеssiоn WHЕN __cоnstаnt_vаluе; 

Внешне данные предложения отличаются от других наличием ключевого 

слова guarded. Это означает, что такой оператор выполняется, когда сигнал-

сторож изменяет свое значение. Если сигнал-сторож изменяет свое значение с 

true на false, драйвер сторожевого сигнала автоматически отсоединяется с ис-

пользованием нулевой транзакции. При изменении значения сигнала-сторожа с 

false на true драйвер вновь присоединяется. 

Рассмотрим пример описания D-триггера с асинхронной установкой в 

ноль. 

ENTITY vdff IS 

 PORT (d, clk, clr  : IN bit; 

  q, q1  : BUFFER bit); 

END ENTITY vdff; 

ARCHITECTURE behav OF vdff IS 

     BEGIN 

 blck: BLOCK (clk = '1' OR clr = '1') 

     BEGIN 

  q <=GUARDED 

'0' WHEN clr = '1' ELSE 

    D WHEN clk = '1' ELSE  

    unaffected; 

  WITH clk&clr SELECT 

   q1 <= GUARDED 

    '0' WHEN "01", 

    d WHEN "10", 

    q1 WHEN others; 

 END BLOCK; 

END ARCHITECTURE behav; 

Временные диаграммы D-триггера с установкой в ноль приведены на ри-

сунке 2.2. 

 

 
 

Рисунок 2.2 – Временные диаграммы работы цифровых устройств, 

описанных с помощью сторожевого сигнала 

Из анализа временных диаграмм следует, что в обоих случаях синтезиро-

ван статический триггер. 
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Описанный выше механизм неявного определения сигналов-сторожей на 

базе сторожевых выражений, задаваемых в заголовке описания блока, ока-

зывается недостаточным для многих моделей. VHDL предоставляет и более 

общий механизм для определения сигнала-сторожа – механизм явного опре-

деления сигнала-сторожа. 

При явном определении сигнал-сторож также имеет булевский тип. При 

изменении его с true на false драйверы сторожевых охраняемых сигналов от-

ключаются, а при изменении с false на true – подключаются. 

Явно определенный сигнал-сторож обязательно должен носить имя guard. 

Его действие распространяется на всю область определения и, соответственно, 

в этой области не может быть другого сигнала-сторожа. 

Рассмотрим особенности применения сигнала-сторожа на примере. 

ENTITY storog IS 

PORT (in1, in2 : IN bit; 

  q, q1  : OUT bit); 

END storog; 

ARCHITECTURE arch OF storog IS 

  BEGIN 

 blck : BLOCK 

   SIGNAL guard : bit; 

  BEGIN 

   guard <= in1; 

   q <= guarded in2; 

   q1 <= in1 AND in2; 

END BLOCK blck; 

END ARCHITECTURE arch; 

Из анализа временных диаграмм, приведенных на рисунке 2.3, видно, что 

по выходу q синтезирован статический D-триггер. 

 

Рисунок 2.3 – Временные диаграммы работы цифровых устройств, 

описанных с помощью сигнала-сторожа 

В сложных проектах иногда возникает необходимость нескольким разра-

ботчикам работать в одной архитектуре. Если разработчик будет использовать 

глобальные имена или параметры настройки, то при возникновении необходи-

мости изменить любое из этих имя необходимо изменять их по всему коду. Во 

избежание этого используют заголовок блока (block_header). 



Методические указания 

 17 

Заголовок блока явно идентифицирует ряд параметров настройки или 

сигналов, которые должны быть импортированы из окружающей среды в блок 

и сопоставлены формальным параметрам настройки или сигналам блока.  

ENTITY cnt1 IS 

   GENERIC (numb :integer:=10; max : integer:=5); 

    PORT ( a, b, c, r  :IN bit; 

    q  : OUT integer RANGE 0 TO numb-1); 

END ENTITY; 

ARCHITECTURE behav OF cnt1 IS 

  SIGNAL clka: bit; 

 BEGIN 

 clka <= a AND b AND c; 

  blck: BLOCK IS 

  GENERIC (numb_b :integer; max_b : integer); 

  GENERIC MAP (numb_b => numb, max_b => max); 

  PORT (clk, res  :IN bit; 

    qb :BUFFER integer RANGE 0 TO numb_b-1); 

  PORT MAP (clk => clka, res => r, qb =>q); 

    BEGIN 

   PROCESS (clk) 

    BEGIN 

      IF r='0' THEN qb <=0; 

        ELSIF (clk'EVENT AND clk ='1') 

       THEN qb <= qb + 1; 

     IF qb = max_b THEN qb <=0; END IF; 

    END IF; 

   END PROCESS; 

  END BLOCK; 

END ARCHITECTURE behav; 

 

Из анализа описания следует, что в одной архитектуре можно не задумы-

ваться над именами параметров настройки и сигналов. Внутренние параметры 

настройки и сигналы видны только в блоке, а связь с внешними параметрами 

настройки и сигналами задают в port map и generic map. 

Цифровое устройство по приведенному описанию представляет собой 

делитель на 5 (смотри рисунок 2.4). 
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Рисунок 2.4 – Временные диаграммы работы делителя на 5 

Декларативная часть позволяет описать объекты, используемые только 

внутри блока, которому она принадлежит. В декларативной части блока описы-

ваются любые типы объектов, которые могут присутствовать в декларативной 

части архитектурного тела. Все объекты, видимые внутри того архитектурного 

тела, к которому принадлежит блок, видимы внутри блока. Сами описания бло-

ков располагаются внутри архитектурного тела. 

Блок может содержать внутри себя другие блоки. Объекты, которые опи-

саны в декларативной части блока, видны только в этом блоке. 

Вложение блоков друг в друга позволяет создавать иерархические струк-

туры моделей. 

Рассмотрим пример. 

ENTITY blck IS 

     PORT (a,b,c : IN bit; 

           q,q1   : OUT bit); 

END blck; 

ARCHITECTURE structure OF blck IS 

  BEGIN 

    block1: BLOCK 

      SIGNAL qb : bit; 

        BEGIN 

          qb <= a AND b; 

          q <= qb; 

    block2: BLOCK 

    SIGNAL q : bit; 

   BEGIN 

     q <= qb AND c; 

     q1 <= q; 

    END BLOCK block2; 

    END BLOCK block1; 

END ARCHITECTURE structure; 

В приведенном примере применены вложенные блоки, а также пояснена 

особенность видимости сигналов. Сигналы с именем q объявлены в интерфейсе 

устройства и во втором блоке. Однако конфликты отсутствуют (смотри рису-

нок 2.5), поскольку внутренний сигнал q виден только во втором блоке. 
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Рисунок 2.5 – Временные диаграммы работы элемента И 

Конфигурирование блоков подобно конфигурированию компонентов. 

Конфигурационная декларация для архитектурного тела, содержащего блоки, 

должна отражать структуру блоков. 

Конфигурационная декларация в этом случае имеет следующий синтак-

сис: 

configuration configuration_name of entity_name is 

    for (architecture_name | block_label) 

    {block_configuration | 

        for component_specification [binding_indication;] [block_configuration] 

        end for;} 

end for 

end [configuration] [configuration_name]; 

Из синтаксиса декларации видно, что секции block_configuration могут 

вкладываться друг в друга. 

Рассмотрим в качестве примера описание устройства с применением ре-

конфигурируемого компонента: триггера, который в зависимости от архитек-

турного тела может выполнять функции T- или D-триггера. 

Описание триггера имеет вид. 

ENTITY dt_blck IS 

   PORT ( dt, c, r  : IN bit; : BUFFER bit); 

END dt_blck; 

ARCHITECTURE d_arch OF dt_blck IS 

    BEGIN 

      PROCESS (c) 

 BEGIN 

     IF r = '0' THEN q <= '0'; 

       ELSIF (c'EVENT AND c= '1') THEN q <= dt; 

  ELSE null; 

               END IF; 

 END PROCESS; 

END d_arch; 

ARCHITECTURE t_arch OF dt_blck IS 

     BEGIN 



Проектирование на VHDL в САПР Quartus II 

 20 

         PROCESS (c) 

  BEGIN 

     IF r = '0' THEN q <= '0'; 

  ELSIF (c'EVENT AND c= '1') THEN 

     IF dt = '1' THEN q <= NOT q; 

   ELSE null; 

     END IF; 

    END IF; 

 END PROCESS; 

END t_arch; 

CONFIGURATION cfg1 OF dt_blck IS -- Configuration Declaration 

 FOR t_arch END FOR; 

END cfg1; 

Описание устройства. 

ENTITY conf_blck IS 

  PORT (d, clk, res : IN bit; 

 qO, qO1 : OUT bit); 

END conf_blck; 

ARCHITECTURE arch OF conf_blck IS 

   COMPONENT dt_blck  

 PORT(dt, c, r : IN bit; q: OUT bit); 

   END COMPONENT; 

   BEGIN 

      level1 : BLOCK 

          PORT (dt1, c1, r1: IN bit; q1: OUT bit); 

                   PORT MAP (dt1 => d, c1 => clk, r1 => res, q1 => qO); 

     BEGIN 

        comp1: dt_blck PORT MAP (dt1, c1, r1, q1); 

             END BLOCK level1; 

             level2 : BLOCK 

  PORT (dt2, c2, r2: IN bit; q2: OUT bit); 

                     PORT MAP (dt2 => d, c2 => clk, r2 => res, q2 => qO1); 

       BEGIN 

          comp2: dt_blck PORT MAP (dt2, c2, r2, q2); 

            END BLOCK level2; 

END ARCHITECTURE arch; 

CONFIGURATION full OF conf_blck IS 

  FOR arch 

    FOR level1 

      FOR comp1: dt_blck 

         use entity work.dt_blck(d_arch); 

      END FOR; 

 END FOR; 

 FOR level2 
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      FOR comp2: dt_blck  

      use entity work.dt_blck(t_arch); 

      END FOR; 

    END FOR; 

  END FOR; 

END CONFIGURATION full; 

Конфигурационной декларацией в первом блоке триггер переведен в ре-

жим D-триггера, а во втором – в режим Т-триггера, что подтверждается вре-

менными диаграммами на рисунке 6. 

2.2 Способы использования компонентов пользователя в САПР 

Quartus 

САПР Quartus позволяет создавать компоненты пользователя и подклю-

чать их несколькими способами. Выбор конкретного способа зависит от даль-

нейшего использования компонента в других проектах, необходимости его мо-

дификации, а также необходимости существования нескольких одноименных 

компонентов. 

Рассмотрим в качестве примера подключение компонента пользователя, 

который преобразует десятичную цифру в семисегментный код. Описание 

сущности и архитектуры компонента на языке VHDL имеет вид: 

 

ENTITY dec_to_7seg IS 

    PORT( digit : IN INTEGER RANGE 0 TO 15; 

                 segment : OUT BIT_VECTOR (6 DOWNTO 0) ); 

END dec_to_7seg; 

 

ARCHITECTURE dec_to_7seg_arh OF dec_to_7seg IS 

BEGIN 

    WITH digit SELECT 

        segment <= "0111111" WHEN 0, 

                   "0000110" WHEN 1, 

                   "1011011" WHEN 2, 

                   "1001111" WHEN 3, 

                   "1100110" WHEN 4, 

                   "1101101" WHEN 5, 

                   "1111101" WHEN 6, 

                   "0000111" WHEN 7, 

                   "1111111" WHEN 8, 

                   "1100111" WHEN 9, 

                   "0000000" WHEN OTHERS; 

END dec_to_7seg_arh; 

Компонент может быть использован при описании устройств, в которых 

применяются статические и динамические семисегментные индикаторы. 
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Разработаем с использованием различных способов подключения компо-

нента простейшее устройство, которое осуществляет счѐт десятичных цифр с 

определѐнной частотой и преобразовывает их в семисегментный код. Переход к 

следующей цифре осуществляется по переднему фронту тактового сигнала, по-

ступающего на вход устройства. После цифры 9 счѐт начинается с 0. Времен-

ные диаграммы работы устройства приведены на рисунке 2.6. 

 

 
Рисунок 2.6 – Временные диаграммы работы преобразователя кодов 

2.2.1 Описание и декларация компонента в одном VHDL-файле 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в САПР QUARTUS 2 (File → New Project Wizard); 

2 создать файл VHDL (File → New → VHDL File). Поместить в файл 

описание компонента; 

3 описать в этом файле сущность и архитектуру устройства; 

4 в архитектуре устройства выполнить декларацию компонента; 

5 сохранить файл (File → Save). При этом имя файла должно совпадать с 

названием сущности устройства. 

6 выполнить компиляцию проекта. 

Пример описания устройства. 

ENTITY dec_to_7seg IS 

    PORT( digit : IN INTEGER RANGE 0 TO 15; 

                 segment : OUT BIT_VECTOR (6 DOWNTO 0) ); 

END dec_to_7seg; 

ARCHITECTURE dec_to_7seg_arh OF dec_to_7seg IS 

    BEGIN 

   WITH digit SELECT 

      segment <=  "0111111" WHEN 0, 

                    "0000110" WHEN 1, 

                          "1011011" WHEN 2, 

                    "1001111" WHEN 3, 

                    "1100110" WHEN 4, 

                    "1101101" WHEN 5, 

                    "1111101" WHEN 6, 

                    "0000111" WHEN 7, 

                    "1111111" WHEN 8, 

                    "1100111" WHEN 9, 

                    "0000000" WHEN OTHERS; 
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END dec_to_7seg_arh; 

ENTITY spos1 IS 

    PORT(clk : IN BIT; 

            seg_out : OUT BIT_VECTOR (0 TO 6)); 

END spos1; 

ARCHITECTURE arch OF spos1 IS 

    COMPONENT dec_to_7seg 

        PORT( digit : IN INTEGER RANGE 0 TO 15; 

                    segment : OUT BIT_VECTOR (6 DOWNTO 0)); 

    END COMPONENT dec_to_7seg; 

    SIGNAL count: INTEGER RANGE 0 TO 15; 

  BEGIN 

    comp: dec_to_7seg PORT MAP (count, seg_out); 

    PROCESS (clk) 

   BEGIN 

                 IF (clk'EVENT and clk='1') THEN 

     count <= count + 1; 

                END IF; 

            END PROCESS; 

END arch; 

 

В окне сообщений на вкладке Processing появятся сообщения: 

Info: Found 4 design units, including 2 entities, in source file spos1.vhd 

 Info: Found design unit 1: dec_to_7seg-dec_to_7seg_arh 

 Info: Found design unit 2: spos1-arch 

 Info: Found entity 1: dec_to_7seg 

 Info: Found entity 2: spos1 

Info: Elaborating entity "spos1" for the top level hierarchy 

Info: Elaborating entity "dec_to_7seg" for hierarchy "dec_to_7seg:comp" 

Таким образом, САПР Quartus определил четыре модуля проектирования 

(design units). Сущностью верхнего уровня является сущность spos1. 

Параметры проекта: 

– количество логических элементов – 11. 

– размер исходного кода проекта – 1239 Байт. 

Преимущества: 

− работа с единственным исходным файлом в проекте. 

Недостатки: 

− невозможно использовать компонент в других проектах; 

− большой объем исходного файла; 

− компонент необходимо декларировать в архитектуре. 
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2.2.2 Описание компонента в отдельном VHDL-файле, расположен-

ном в каталоге с проектом 

Единственным отличием этого способа от предыдущего состоит в том, 

что описание компонента (сущность и архитектура) выносится в отдельный 

файл. 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в САПР Quartus (File → New Project Wizard); 

2 создать файл VHDL (File → New → VHDL File). Поместить в файл 

описание компонента, которое включает в себя сущность и архитектуру; 

3 сохранить файл (File → Save). При этом имя файла должно совпадать с 

названием сущности компонента; 

4 создать ещѐ один файл VHDL (File → New → VHDL File). Описать в 

файле сущность и архитектуру устройства; 

5 в архитектуре устройства выполнить декларацию и подключение 

компонента. 

6 сохранить файл (File → Save). При этом имя файла должно совпадать с 

названием сущности устройства. 

7 выполнить компиляцию проекта. 

Рассмотрим пример. 

Описание компонента. 

ENTITY dec_to_7seg IS 

    PORT( digit : IN INTEGER RANGE 0 TO 15; 

                 segment  : OUT BIT_VECTOR (6 DOWNTO 0) ); 

END dec_to_7seg; 

ARCHITECTURE dec_to_7seg_arh OF dec_to_7seg IS 

BEGIN 

    WITH digit SELECT 

        segment <=  

"0111111" WHEN 0, 

                   "0000110" WHEN 1, 

                   "1011011" WHEN 2, 

                   "1001111" WHEN 3, 

                   "1100110" WHEN 4, 

                   "1101101" WHEN 5, 

                   "1111101" WHEN 6, 

                   "0000111" WHEN 7, 

                   "1111111" WHEN 8, 

                   "1100111" WHEN 9, 

                   "0000000" WHEN OTHERS; 

END dec_to_7seg_arh; 

Описание устройства. 

ENTITY spos2 IS 

    PORT(clk : IN BIT; 
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               seg_out  : OUT BIT_VECTOR (0 TO 6)); 

END spos2; 

ARCHITECTURE arch OF spos2 IS 

    COMPONENT dec_to_7seg 

        PORT( digit : IN INTEGER RANGE 0 TO 15; 

               segment: OUT BIT_VECTOR (6 DOWNTO 0)); 

    END COMPONENT dec_to_7seg; 

 SIGNAL count: INTEGER RANGE 0 TO 15; 

  BEGIN 

    comp: dec_to_7seg PORT MAP (count, seg_out); 

    PROCESS (clk) 

   BEGIN 

                IF (clk'EVENT and clk='1') THEN 

     count <= count + 1; 

                END IF; 

            END PROCESS; 

END arch; 

В окне сообщений на вкладке Processing появятся сообщения: 

Info: Found 2 design units, including 1 entities, in source file dec_to_7seg.vhd 

 Info: Found design unit 1: dec_to_7seg-dec_to_7seg_arh 

 Info: Found entity 1: dec_to_7seg 

Info: Found 2 design units, including 1 entities, in source file spos2.vhd 

 Info: Found design unit 1: spos2-arch 

 Info: Found entity 1: spos2 

Info: Elaborating entity "spos2" for the top level hierarchy 

Info: Elaborating entity "dec_to_7seg" for hierarchy "dec_to_7seg:comp" 

Таким образом, САПР Quartus определил четыре модуля проектирования 

(design units). Сущностью верхнего уровня является сущность spos2. 

Параметры проекта: 

– количество логических элементов – 11. 

– размер исходного кода dec_to_7seg – 667 байт, а spos2 – 570 байт. 

Преимущества: 

− отдельный файл с описанием компонента можно использовать в других 

проектах; 

− каждый файл отвечает за описание сущности и архитектуры, что 

упрощает читаемость кода. 

Недостатки: 

− для использования файла описания компонента в другом проекте его 

нужно скопировать, а это приводит к нерациональному дублированию кода. 

Кроме того, при необходимости внести изменения в описание компонента, 

необходимо их вносить во все скопированные файлы; 

− компонент нужно декларировать в архитектуре. 
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2.2.3 Описание компонента в отдельном VHDL-файле, расположен-

ном вне каталога с проектом 

Для устранения основного недостатка второго способа, файл с описанием 

компонента можно поместить в отдельный каталог и, в дальнейшем, при созда-

нии новых проектов указывать этот файл. 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в Quartus (File → New Project Wizard); 

2 создать каталог вне проекта и поместить в него файл с описанием 

компонента; 

3 создать файл VHDL(File → New → VHDL File). Описать в файле 

сущность и архитектуру устройства; 

4 выполнить в архитектуре устройства декларацию компонента; 

8 сохранить файл (File → Save). При этом имя файла должно совпадать с 

названием сущности устройства; 

5 зайти в Project → Add/Remove Files in Project… → Вкладка Files и 

выбрать файл с описанием компонента; 

6 выполнить компиляцию проекта. 

Рассмотрим пример разработки устройства. 

Предварительно занесем описание компонента dec_to_7seg во вновь со-

зданную директорию libs и подключим его к проекту командой Project → 

Add/Remove Files in Project… → Вкладка Files. Список проектных файлов пока-

зан на рисунке 2.7. 

 

 

Рисунок 2.7 – Список проектных файлов проекта spos3  

Затем создадим в проекте файл spos3.vhd, содержание которого совпадает 

с файлом spos2.vhd за исключением имени проекта. 

 Параметры проекта: 

– количество логических элементов – 11. 

– размер исходного кода dec_to_7seg – 667 байт, а spos3 – 570 байт. 

Преимущества: 

− можно использовать файл с описанием компонента во многих 

проектах. 

− файл описания можно изменять из любого проекта после его 

подключения. При этом его содержание будет меняться во всех остальных 

проектах. 

− Недостатки: 

− компонент необходимо в архитектуре.  



Методические указания 

 27 

2.2.4 Описание компонента в пакете, расположенном в каталоге с 

проектом 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в Quartus (File → New Project Wizard); 

2 создать каталог вне проекта и поместить в него файл с описанием 

компонента; 

3 создать пакет в проекте (File → New → VHDL File). В пакете 

выполнить декларацию компонента; 

4 сохранить файл (File → Save). При этом имя файла должно совпадать с 

именем пакета; 

5 создать файл VHDL в проекте (File → New → VHDL File). Описать в 

файле сущность и архитектуру устройства. В архитектуре устройства 

выполнить декларацию компонента не следует. При этом имя файла должно 

совпадать с названием сущности устройства; 

6 подключить с помощью опции в Project → Add/Remove Files in 

Project… → Вкладка Files файлы с описанием пакета и компонента; 

7 подключить пакета добавления в файл описания предложений:  

          LIBRARY work; 

USE work.<имя пакета>.ALL; 

Вместо ALL можно указать только имя компонента, тогда остальные де-

кларации из пакета не будут подключены; 

8 выполнить компиляцию проекта. 

Рассмотрим пример разработки устройства. 

Предварительно занесем описание компонента dec_to_7seg и пакета 

pack_dec_to_7seg во вновь созданную директорию libs и подключим их к про-

екту командой Project → Add/Remove Files in Project… → Вкладка Files. Список 

проектных файлов показан на рисунке 2.8. 

  

Рисунок 2.8 – Список проектных файлов проекта spos4 

Описание пакета. 

PACKAGE pack_dec_to_7seg IS 

    COMPONENT dec_to_7seg 

        PORT(digit  : IN INTEGER RANGE 0 TO 15; 

             segment : OUT BIT_VECTOR (6 DOWNTO 0)); 

    END COMPONENT dec_to_7seg; 

END PACKAGE; 

Описание устройства. 
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LIBRARY work; 

USE work.pack_dec_to_7seg. ALL; 

ENTITY spos4 IS 

    PORT(clk : IN BIT; 

               seg_out  : OUT BIT_VECTOR (0 TO 6)); 

END spos4; 

ARCHITECTURE arch OF spos4 IS 

     SIGNAL count: INTEGER RANGE 0 TO 15; 

  BEGIN 

    comp: dec_to_7seg PORT MAP (count, seg_out); 

     PROCESS (clk) 

        BEGIN 

                IF (clk'EVENT and clk='1') THEN 

    count <= count + 1; 

                END IF; 

             END PROCESS; 

END arch; 

В окне сообщений на вкладке Processing появятся сообщения: 

Info: Found 1 design units, including 0 entities, in source file 

../libs/pack_dec_to_7seg.vhd 

Info: Found design unit 1: pack_dec_to_7seg 

Info: Found 2 design units, including 1 entities, in source file 

../libs/dec_to_7seg.vhd 

Info: Found design unit 1: dec_to_7seg-dec_to_7seg_arh 

Info: Found entity 1: dec_to_7seg 

Info: Found 2 design units, including 1 entities, in source file spos4.vhd 

Info: Found design unit 1: spos4-arch 

Info: Found entity 1: spos4 

Info: Elaborating entity "spos4" for the top level hierarchy 

Info: Elaborating entity "dec_to_7seg" for hierarchy "dec_to_7seg:comp" 

Таким образом, САПР Quartus определил пять модулей проектирования 

(design units). Сущностью верхнего уровня является сущность spos4. 

Параметры проекта: 

– количество логических элементов - 11. 

– размер исходного кода dec_to_7seg - 667 байт, pack_dec_to_7seg – 209 

байт, а spos4 - 455 байт. Размер файла проекта уменьшился, поскольку отсут-

ствует декларация компонента. 

Преимущества: 

– в архитектуре главной сущности уже не нужно выполнять декларацию 

компонента. 

– пакет позволяет разграничить области имен. Это означает, что можно 

создать два разноимѐнных пакета, но с одноименными компонентами внутри. 

Это удобно при необходимости подключения компонентов с одинаковой 

функциональностью, но разной реализацией. 
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Недостатки: 

– необходимость создания пакета; 

– следует к файлу проекта подключать два файла. 

2.2.5 Описание компонента в одном файле с декларацией пакета 

Для уменьшения количество подключаемых файлов следует поместить 

описание самого компонента вместе с декларацией пакета. 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в Quartus (File → New Project Wizard). 

2 создать каталог вне проекта. Поместить в этот файл декларацию пакета, 

а также с описание сущности и архитектуры компонента. 

3 создать файл проекта VHDL (File → New → VHDL File). Описать в 

файле сущность и архитектуру устройства. В архитектуре устройства 

выполнить декларацию компонента не нужно. Сохранить файл (File → Save). 

При этом имя файла должно совпадать с названием сущности устройства. 

4 Выполнить подключение пакета добавлением в файл проекта 

предложений: 

LIBRARY work; 

USE work.<имя пакета>.ALL; 

Вместо ALL можно указать только имя компонента, тогда остальные де-

кларации из пакета не будут подключены. 

5 зайти в Project → Add/Remove Files in Project… → Вкладка Files. 

Подключитьь файл с декларацией пакета 

6 выполнить компиляцию проекта. 

Рассмотрим пример разработки устройства. 

Создадим описание пакета. 

PACKAGE pack1_dec_to_7seg IS 

    COMPONENT dec_to_7seg 

        PORT(digit  : IN INTEGER RANGE 0 TO 15; 

             segment : OUT BIT_VECTOR (6 DOWNTO 0)); 

    END COMPONENT dec_to_7seg; 

END PACKAGE; 

ENTITY dec_to_7seg IS 

    PORT(  digit    : IN INTEGER RANGE 0 TO 15; 

            segment  : OUT BIT_VECTOR (6 DOWNTO 0) ); 

END dec_to_7seg; 

ARCHITECTURE dec_to_7seg_arh OF dec_to_7seg IS 

BEGIN 

    WITH digit SELECT 

        segment <= "0111111" WHEN 0, 

                   "0000110" WHEN 1, 

                   "1011011" WHEN 2, 

                   "1001111" WHEN 3, 

                   "1100110" WHEN 4, 



Проектирование на VHDL в САПР Quartus II 

 30 

                   "1101101" WHEN 5, 

                   "1111101" WHEN 6, 

                   "0000111" WHEN 7, 

                   "1111111" WHEN 8, 

                   "1100111" WHEN 9, 

                   "0000000" WHEN OTHERS; 

END dec_to_7seg_arh; 

 

Занесем описание компонента пакета pack1_dec_to_7seg во вновь создан-

ную директорию libs и подключим их к проекту командой Project → 

Add/Remove Files in Project… → Вкладка Files. Список проектных файлов пока-

зан на рисунке 2.9. 

 

  
Рисунок 2.9 – Список проектных файлов проекта spos4 

Создадим файл проекта spos5.vhd, который совпадает с файлом spos4.vhd 

за исключением подключения пакета. Предложение Use Clause имеет вид: 

USE work.pack1_dec_to_7seg.hex_to_7seg; 

При компиляции проекта получены следующие сообщения: 

Info: Found 2 design units, including 1 entities, in source file spos5.vhd 

 Info: Found design unit 1: spos5-arch 

 Info: Found entity 1: spos5 

Info: Found 3 design units, including 1 entities, in source file 

../libs/pack1_dec_to_7seg.vhd 

 Info: Found design unit 1: pack1_dec_to_7seg 

 Info: Found design unit 2: dec_to_7seg-dec_to_7seg_arh 

 Info: Found entity 1: dec_to_7seg 

Info: Elaborating entity "spos5" for the top level hierarchy 

Info: Elaborating entity "dec_to_7seg" for hierarchy "dec_to_7seg:comp" 

Видно, что при анализе файла pack1_dec_to_7seg.vhd Quartus нашел три 

модуля проектирования: декларация пакета, описание архитектуры компонента, 

описание сущности компонента. 

Параметры проекта: 

– количество логических элементов – 11. 

– размер исходного кода – pack1_dec_to_7seg.vhd – 874 байтa, а spos5 – 

456 байт. 

Преимущество состоит в простоте применения компонента в других про-

ектах. 
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2.2.6 Подключение компонента, декларированного в пакете, без при-

менения предложения Use Clause 

Вместо применения предложения Use Clause тип компонента указывают в 

формате <имя библиотеки>.<имя компонента>. 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в Quartus (File → New Project Wizard); 

2 создать новый каталог вне проекта и поместить в него файл с 

декларацией пакета, а также с описанием сущности и архитектуры компонента. 

3 создать файл VHDL в проекте (File → New → VHDL File). Описать в 

файле сущность и архитектуру устройства. В архитектуре устройства 

выполнить декларацию компонента не нужно. При этом имя файла должно 

совпадать с названием сущности устройства. 

4 при объявлении компонента указать его тип в формате <имя 

библиотеки>.<имя компонента> 

5 зайти в Project → Add/Remove Files in Project… → Вкладка Files и 

выбрать файл с декларацией пакета и описанием компонента. 

6 выполнить компиляцию проекта. 

Рассмотрим пример разработки устройства. 

Применим пакет pac1_dec_to_7seg.vhd, который находится в каталоге libs. 

Описание устройства имеет вид. 

ENTITY spos6 IS 

    PORT(clk : IN BIT; 

         seg_out : OUT BIT_VECTOR (0 TO 6)); 

END spos6; 

ARCHITECTURE arch OF spos6 IS 

 SIGNAL count: INTEGER RANGE 0 TO 15; 

  BEGIN 

    comp: work.dec_to_7seg PORT MAP (count, seg_out); 

        PROCESS (clk) 

   BEGIN 

             IF (clk'EVENT and clk='1') THEN 

    count <= count + 1; 

             END IF; 

           END PROCESS; 

END arch; 

Параметры проекта: 

количество логических элементов – 11. 

размер исходного кода – pack1_dec_to_7seg.vhd – 874 байтa, а spos6 – 411 

байт. 

Преимущества: 

– минимальный размер файла проекта; 

– содержимое пакета не отображается на всю область видимости VHDL-

файла, что позволяет исключить проблему одинаковых идентификаторов. 
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Недостаток – при многоразовом использовании компонента следует всѐ 

время указывать имя библиотеки. 

2.2.7 Описание пакета, компонента и устройства в одном файле 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в Quartus (File → New Project Wizard); 

2 создать файл VHDL в проекте (File → New → VHDL File). Описать 

пакет и в нѐм выполнить декларацию компонента.  

3 подключить пакет в созданном файле добавлением в файл 

предложений: 

LIBRARY <имя библиотеки>; 

USE <имя библиотеки>.<имя пакета>.ALL; 

4 описать в файле сущность и архитектуру устройства; 

5 сохранить файл (File → Save). При этом имя файла должно 

соответствовать названию сущности устройства. 

6 выполнить компиляцию проекта. 

Пример описания устройства. 

PACKAGE pack1_dec_to_7seg IS 

    COMPONENT dec_to_7seg 

        PORT(digit  : IN INTEGER RANGE 0 TO 15; 

                   segment : OUT BIT_VECTOR (6 DOWNTO 0)); 

    END COMPONENT dec_to_7seg; 

END PACKAGE; 

 

ENTITY dec_to_7seg IS 

    PORT( digit : IN INTEGER RANGE 0 TO 15; 

               segment : OUT BIT_VECTOR (6 DOWNTO 0) ); 

END dec_to_7seg; 

ARCHITECTURE dec_to_7seg_arh OF dec_to_7seg IS 

BEGIN 

    WITH digit SELECT 

        segment <= "0111111" WHEN 0, 

                   "0000110" WHEN 1, 

                   "1011011" WHEN 2, 

                   "1001111" WHEN 3, 

                   "1100110" WHEN 4, 

                   "1101101" WHEN 5, 

                   "1111101" WHEN 6, 

                   "0000111" WHEN 7, 

                   "1111111" WHEN 8, 

                   "1100111" WHEN 9, 

                   "0000000" WHEN OTHERS; 

END dec_to_7seg_arh; 
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LIBRARY work; 

USE work.pack1_dec_to_7seg. ALL; 

ENTITY spos7 IS 

    PORT(clk      : IN BIT; 

               seg_out  : OUT BIT_VECTOR (0 TO 6)); 

END spos7; 

ARCHITECTURE arch OF spos7 IS 

 SIGNAL count: INTEGER RANGE 0 TO 15; 

  BEGIN 

    comp: dec_to_7seg PORT MAP (count, seg_out); 

    PROCESS (clk) 

   BEGIN 

             IF (clk'EVENT and clk='1') THEN 

         count <= count + 1; 

                  END IF 

            END PROCESS; 

END arch; 

Параметры проекта: 

– количество логических элементов – 11. 

– размер исходного кода – spos7 - 1334 байт. 

Преимущества: 

– при одноразовом использовании компонента минимальны усилия по 

управлению файлами; 

– пакет даѐт возможность создать разные пространства имѐн. 

Недостатки: 

− максимальный размер исходного файла проекта; 

− трудность использования файла для других проектов. 

2.2.8 Подключение компонента из библиотеки 

В Quartus библиотека представляет собой каталог, в котором находятся 

файлы проектных модулей (design units). 

Библиотеки бывают двух видов: библиотки проекта (Project Libraries) – 

подключаемые единожды в один проект и глобальные – подключаемые во все 

проекты, которые создаются в Quartus. Поэтому настройки библиотеки проекта 

хранятся в файле qsf, который входит в проект, а настройки глобальных 

библиотек в файле системы (quartus2.ini). 

Для подключения библиотеки необходимо указать путь к определѐному 

каталогу. По умолчанию все созданные пакеты помещаются в псевдо-

библиотеку work, независимо от того, в каких каталогах размещены файлы с 

декларацией этих пакетов. 

Создавать устройства необходимо в следующей последовательности: 

1 создать проект в Quartus (File → New Project Wizard). 

2 создать каталог библиотеки проекта. В нем создать файл с декларацией 

пакета, а также с описанием сущности и архитектуры компонента. 
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3 создать файл VHDL в проекте (File → New → VHDL File). Описать в 

файле сущность и архитектуру устройства. В архитектуре устройства 

декларацию компонента не проводить. Сохранить файл (File → Save). При этом 

имя файла должно совпадать с названием сущности устройства. 

4 Выполнить подключение пакета путѐм добавления в файл 

предложений: 

          LIBRARY <имя библиотеки>; 

          USE <имя библиотеки>.<имя пакета>.ALL; 

5 зайти в Project → Add/Remove Files in Project… → Вкладка Libraries. 

Выбрать каталог библиотеки, нажать Add, OK; 

6 зайти в Project → Add/Remove Files in Project… → Вкладка Files и 

указать имя файл с декларацией пакета и описанием сущности и архитектуры 

компонента. 

7 Выполнить компиляцию проекта. 

Пример описания устройства. 

Файл с декларацией пакета, а также с описанием сущности и архитектуры 

компонента помещен в каталог libs. 

LIBRARY libs; 

USE libs.pack1_dec_to_7seg. ALL; 

ENTITY spos8 IS 

    PORT(clk        : IN BIT; 

               seg_out : OUT BIT_VECTOR (0 TO 6)); 

END spos8; 

ARCHITECTURE arch OF spos8 IS 

 SIGNAL count: INTEGER RANGE 0 TO 15; 

  BEGIN 

      comp: dec_to_7seg PORT MAP (count, seg_out); 

          PROCESS (clk) 

     BEGIN 

                 IF (clk'EVENT and clk='1') THEN 

    count <= count + 1; 

                      END IF; 

             END PROCESS; 

END arch; 

Списки библиотек и проектных файлов показаны на рисунке 2.10 и 2.11. 

 
 

Рисунок 2.10 – Список библиотек проекта spos8 
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Рисунок 2.11 – Список проектных файлов проекта spos8 

Параметры проекта: 

– количество логических элементов – 11. 

– размер исходного кода – pack1_dec_to_7seg.vhd – 874 байтa, spos8 – 454 

байта. 

Преимущества: 

– библиотеки позволяют объединить несколько проектных файлов в 

единое целое и разграничить области видимости имен с другим библиотеками 

на уровне пакетов; 

–  независимость пути к проектным файлам от дерева файловой системы. 

Позволяет намного проще переносить библиотеки между системами. 

Недостатки: 

− необходимость дополнительно указывать путь к библиотеке. 

2.2.9 Сравнительный анализ способов подключения компонентов 

Сравним рассмотренные способы по сложности реализации и объему 

файлов проекта (смотри таблицу 2.1). 

 

Таблица 2.1 – Объем файлов проекта и сложность реализации способов 

Номер 
Объем файлов проекта 

(байт) 

Суммарный 

объем файлов 

Сложность 

реализации 

1 spos1 1239 1239 

11 элементов 

2 
dec_to_7seg 667 

1237 
spos2 570 

3 
dec_to_7seg 667 

1237 
spos3 570 

4 

pack_dec_to_7seg 209 

1331 dec_to_7seg 667 

spos4 455 

5 
pack1_dec_to_7seg 874 

1330 
spos5 456 

6 
pack1_dec_to_7seg 874 

1285 
spos6 411 

7 spos7 1334 1334 

8 
pack1_dec_to_7seg 874 

1328 
spos8 454 
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Следует стремиться подключить компонент самым простым способом, то 

есть при использовании компонента определить только необходимые настрой-

ки. Выполнять же декларацию компонента в проекте, в котором он использует-

ся, не является удачным решением. В этом случае размер кода больше, возрас-

тает вероятность допустить ошибку. Кроме того, при изменении интерфейсной 

части компонента придѐтся изменять ещѐ и декларацию компонента, причѐм в 

каждом проекте, который использует данный компонент. Намного удобнее по-

местить декларацию в пакет, и в дальнейшем просто подключать этот пакет в 

каждый проект. 

В пакете можно сгруппировать несколько компонентов со схожей функ-

циональностью для того, чтобы логически систематизировать набор компонен-

тов. Таким образом, когда разработчику необходимо решить определѐнную за-

дачу, он воспользуется несколькими компонентами с нужными функциями, для 

решения другой похожей задачи ему понадобится этот же набор компонентов. 

Для проектов, решающих другой круг задач, разработчику понадобится другой 

набор компонентов, то есть другой пакет. К тому же в пакетах можно деклари-

ровать не только компоненты, но и функции, константы, типы. 

При разработке иногда возникают случаи, когда необходимо определить 

несколько компонентов с одинаковыми именами. В этом случае необходимо 

разделить (разграничить) пространства имѐн. Выполнить такое разграничение 

можно либо при применении пакетов (одноименные компоненты подключают-

ся в разноимѐнные пакеты), либо при применении библиотек. Библиотеки по-

могают разграничить пространство имѐн на уровне пакетов, то есть одноимѐн-

ные пакеты могут использоваться в разноимѐнных библиотеках. 

2.3 Предложения Assertion Statement и Report Statement 

В процессе разработки устройств на языках описания аппаратуры перед 

проверкой работоспособности на реальном устройстве целесообразно выпол-

нить предварительное тестирование написанной программы на виртуальном 

устройстве, называемом симулятором. 

Симулятор (от англ. simulate – моделировать) – специальное программное 

обеспечение (существующее независимо, либо входящее в состав САПР), спо-

собное воспроизвести работу реального устройства. Процесс такого воспроиз-

ведения называется моделированием. В результате процесса моделирования 

разработчик может оценивать изменение состояний выходов микросхемы в за-

висимости от заданных состояний входов. 

Результат моделирования традиционно представляется в виде временных 

диаграмм, на которых отображены зависимости изменения выходных сигналов 

от входных сигналов. Однако такое представление результатов имеет ряд недо-

статков: отсутствует возможность просмотреть результаты вычисления опреде-

лѐнных выражений или переменных; нет возможности оценить разветвленные 

алгоритмы программы; кроме того, нет возможности автоматически прокон-

тролировать значения выходных сигналов, и это приходится делать каждый раз 
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“визуально”. При многократном тестировании устройств такой традиционный 

подход является неэффективным и некачественным. 

Дополнительным подходом к тестированию является программная про-

верка результатов работы устройства и отображение их в журнале симулятора. 

Журнал симулятора – это поток текстовой информации, который генери-

руется симулятором в процессе выполнения моделирования. Обычно отобра-

жение такого потока реализуется путѐм отображения текстовой информации в 

так называемой консоли – виртуальной области дисплея, доступной пользова-

телю для взаимодействия с потоком. Через консоль пользователь может не 

только просматривать информацию, но и вводить команды для управления 

процессом моделирования (например, загрузка скомпилированных файлов в 

симулятор, запуск процесса моделирования). Вместе с консолью текстовый по-

ток может помещаться в файл, который используют для сохранения результа-

тов моделирования. 

Итак, в основе дополнительного подхода лежит механизм передачи дан-

ных из исходного VHDL-кода в текстовый поток журнала с помощью специ-

альных предложений утверждения и отчета. 

2.3.1 Оператор утверждения (Assertion statement) 

Предложение Assertion Statement проверяет заданное условие и генериру-

ет отчет об ошибке, если это условие не выполнилось. Формат предложения: 

assertion_statement ::= [ label: ] assertion ; 

assertion ::= 

assert condition 

[ report expression ] 

[ severity expression ] 

Условие (condition) в обязательном предложении assert должно быть вы-

ражение типа Boolean. Необязательное предложение report должно включать 

выражение типа STRING, которое определяет сообщение, выводимое в резуль-

тирующий отчет. Если предложение report не указать, то в отчет будет выведе-

на строка: "Assertion violation." Необязательное предложение severity указывает 

степень серьѐзности утверждения. Выражение может принимать одно из четы-

рех значений: 

NOTE – сообщение (не важное утверждение); 

WARNING – предупреждение; 

ERROR – ошибка; 

FAILURE – отказ. 

Если предложение severity не указано, то автоматически устанавливается 

степень серьѐзности ERROR. 

При невыполнении условия в предложении assert будут выполнены 

предложения report и severity (если они присутствуют) и на их основе состав-

лено сообщение об ошибке, которое будет выведено в отчет. 
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Предложение Assert Statement может использоваться как в качестве па-

раллельного предложения, так и в качестве последовательного. 

Сообщение об ошибке состоит, по крайней мере, из: 

– указания, что данное сообщение сгенерировано предложением утвер-

ждения; 

– имени модуля проекта, содержащего это утверждение; 

– значения строки сообщения; 

– значения уровня серьѐзности. 

2.3.2 Предложение Report statement 

C помощью этого предложения можно выполнять безусловную генера-

цию сообщений в отчѐте. Формат предложения: 

report_statement ::= 

[ label : ] 

 report expression 

 [ severity expression ] ; 

Обязательное предложение report должно включать выражение типа 

STRING, которое определяет сообщение, выводимое в результирующий отчет. 

Необязательное предложение severity указывает степень серьѐзности утвер-

ждения. Может принимать такие же значения, как и в операторе утверждения. 

Если предложение не указано, то автоматически устанавливается степень серь-

ѐзности NOTE. 

Предложение Report Statement может использоваться в САПР Quartus 

только в качестве последовательного предложения. 

Сообщение об ошибке состоит, по крайней мере, из: 

– указания, что данное сообщение сгенерировано предложением отчета; 

– имени модуля проекта, содержащего это утверждение; 

– значения строки сообщения; 

– значения уровня серьѐзности. 

2.3.3 Применение предложений Assertion Statement и Report Statement 

в различных САПР 

Продемонстрируем применение утверждений и отчѐтов в языке VHDL на 

примере простого дешифратора, описание которого имеет вид: 

ENTITY decod IS 

   PORT (x   : IN bit_vector (0 TO 1); 

      Y, Z  : OUT bit_vector(0 TO 3)); BEGIN 

  ASSERT false REPORT "Compilation entity" SEVERITY WARNING; 

  ASSERT false SEVERITY WARNING; 

END decod; 

ARCHITECTURE desh_arch OF decod IS 

   FUNCTION case_f(vxod:IN bit_vector (0 TO 1))RETURN bit_vector IS 

      VARIABLE case_out:bit_vector(0 TO 3); 
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         BEGIN 

            CASE vxod IS 

  WHEN "00"=>case_out:="1000"; 

  WHEN "10"=>case_out:="0100"; 

  WHEN "01"=>case_out:="0010"; 

  WHEN "11"=>case_out:="0001"; 

  END CASE; 

  RETURN case_out; 

          END case_f; 

      BEGIN 

        ASSERT false REPORT "Concurrent Statement"  

                               SEVERITY WARNING;  

   PROCESS (X) 

       BEGIN 

                 ASSERT false REPORT "Sequential Statement"  

                                                  SEVERITY WARNING;  

        REPORT "Calculation z" SEVERITY WARNING; 

         z<=case_f(X); 

        REPORT "Calculation y" SEVERITY WARNING;  

         y<=case_f(X); 

   END PROCESS; 

END desh_arch; 

В САПР Quartus сообщения в консоль выводятся только при компиляции 

описания цифрового устройства. Сообщения имеют вид: 

Warning (10651): VHDL Assertion Statement at decod.vhd(5): assertion is 

false - report "Compilation entity" (WARNING) 

Warning (10651): VHDL Assertion Statement at decod.vhd(6): assertion is 

false - report Assertion violation (WARNING) 

Warning (10651): VHDL Assertion Statement at decod.vhd(21): assertion is 

false - report "Concurrent Statement" (WARNING) 

Warning (10651): VHDL Assertion Statement at decod.vhd(24): assertion is 

false - report "Sequential Statement" (WARNING) 

Warning (10636): VHDL Report Statement at decod.vhd(25): "Calculation z" 

(WARNING) 

Warning (10636): VHDL Report Statement at decod.vhd(27): "Calculation y" 

(WARNING) 

Сообщения позволяют контролировать этап, на котором в данный момент 

находится компиляция описания, что важно при создании сложных цифровых 

устройств. 

При моделировании в САПР Quartus сообщения по предложениям утвер-

ждения и отчеты в консоль и файлы отчеты не выводятся. Поэтому рассмотрим 

особенности работы в САПР ModelSim Altera Starter Edition 6.5e на следующем 

примере синхронного RS-триггера: 

ENTITY rs_ff IS 
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    PORT (R,S, clk  : in bit; 

       Q, nQ : buffer bit);  

END ENTITY rs_ff; 

ARCHITECTURE rsff OF rs_ff IS 

   BEGIN 

      PROCESS(clk) 

        BEGIN 

  IF (clk'EVENT AND clk = '1') THEN 

    IF (R = '1' AND S ='0') THEN  Q <= '0'; nQ <= '1'; 

           ELSIF (R = '0' AND S ='1') THEN  Q <= '1'; nQ <= '0'; 

  ELSIF (R = '0' AND S ='0') THEN Q <= Q; nQ <= nQ ; 

      ELSIF (R = '1' AND S ='1') THEN Q <= '0'; nQ <= '0'; 

    ASSERT (R AND S)='0' REPORT "R = S= 1" SEVERITY note; 

      END IF; 

 END IF; 

    END process; 

END rsff; 

При моделировании в консоли появится сообщение о запрещенной ком-

бинации (смотри рисунок 2.12), что позволяет довольно таки просто определять 

критические ситуации. 

 

 
Рисунок 2.12 – Сообщения в консоли САПР ModelSim 
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3 РАСЧЁТНО-ГРАФИЧЕСКАЯ РАБОТА 

3.1 Цель и порядок выполнения расчѐтно-графической работы 

Расчѐтно-графическая работа является одним из видов учебной работы, в 

процессе выполнения которой студент для решения поставленных задач при-

меняет на практике те знания, которые были приобретены им при освоении 

теоретических основ учебной дисциплины. В результате он закрепляет полу-

ченные ранее знания, расширяет их, а также приобретает навыки и умения 

практического решения типовых задач учебной дисциплины. 

Темой расчѐтно-графической работы по дисциплине “Технологии проек-

тирования компьютерных систем” является поведенческое описание схемотех-

нических устройств на языке VHDL. 
Целью выполнения расчѐтно-графической работы является приобретение 

практических навыков поведенческого описания сложных схемотехнических 

устройств средствами языка VHDL. 

Выполнение расчѐтно-графической работы включает следующие обяза-

тельные этапы: 

– анализ известных методов построения заданного устройства; 

– разработку схемы алгоритма функционирования устройства; 

– разработку поведенческого описания на языке VHDL последовательно-

го или комбинационного устройства согласно варианту задания; 

– анализ работоспособности описанного устройства и оценка соответ-

ствия заданным требованиям по временным диаграммам; 

– исправление выявленных ошибок, а также внесение изменений (при 

необходимости); 

– выводы о проделанной работе; 

– оформление отчѐта о выполнении расчѐтно-графической работы. 

Каждое задание для выполнения расчѐтно-графической работы состоит из 

нескольких уровней. Каждый последующий уровень имеет более высокую 

сложность и оценивается более высоким количеством баллов по сравнению с 

предыдущими. 

Выполнение задания более высокого уровня подразумевает обязательное 

выполнение всех заданий более низких уровней, 

Практическая часть расчѐтно-графической работы выполняется при по-

мощи инструментальных средств САПР Quartus II от компании Altera. Реко-

мендуется использовать номера версий указанного САПР, начиная с 9.0 и вы-

ше. 

3.2 Требования к отчѐту о выполнении расчѐтно-графической работы 

Отчѐт о выполнении расчѐтно-графической работы оформляется на стан-

дартных листах формата А4 в соответствии с требованиями СОККР-2001 ка-

федры ИКС. 

Отчѐт о выполнении расчѐтно-графической работы должен содержать 

следующие обязательные структурные элементы: 
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– титульный лист с указанием темы расчѐтно-графической работы; 

– анализ известных методов построения заданного устройства (объѐмом 

не менее 4-х листов формата А4), раскрывающие особенности внутреннего по-

строения и функционирования, как самого устройства, указанного в задании, 

так и класса схемотехнических устройств, к которому оно относится; 

– описание варианта задания, обязательно содержащее таблицу задания, 

состоящую из тех уровней, которые были выполнены непосредственно; 

– разработка схемы алгоритма функционирования устройств (с необхо-

димым текстовым описанием); 

– разработка поведенческого описания устройства на языке VHDL, пред-

ставленное с необходимым форматированием и содержащее подробные ком-

ментарии (смотри пункт 3.4.4); 

– анализ работоспособности описанного устройства и оценка соответ-

ствия заданным требованиям (этот анализ проводится на основании получен-

ных временных диаграмм функционирования устройства), содержащий необ-

ходимые пояснения, причѐм на приведенных временных диаграммах должны 

быть представлены все комбинации входных сигналов, как указано в задании; 

– выводы (здесь необходимо произвести подведение итогов проделанной 

работы, оценку полученных результатов, указать особенности применѐнных 

предложений языка VHDL). 

Каждый из структурных элементов нумеруется, как отдельный раздел и 

начинается с нового листа. 

3.3 Варианты заданий 

Ниже, в таблицах 3.1 – 3.15, приводятся варианты заданий для выполне-

ния расчѐтно-графической работы по дисциплине “Технологии проектирования 

компьютерных систем”. 
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Задание №1 

 

Разработать поведенческое описание синхронного счѐтчика. 

 

Таблица 3.1 – Задание №1 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Счѐтчик содержит асинхронный вход сброса Res, асин-

хронный вход установки Set, счѐтный вход Clk, вход разрешения 

счѐта Enable, выход Result[...]. 

Разрядность выходного сигнала Result[...] счѐтчика задается 

как статический параметр, значение которого должно быть не ме-

нее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе счѐтчика устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе счѐтчика устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

Если же на обоих входах Res и Set одновременно удержива-

ется низкий уровень, выход счѐтчика переходит в Z-состояние. 

При условии, что на входах Res, Set, Enable удерживается 

высокий уровень сигнала, счѐтчик осуществляет насчѐт импуль-

сов, поступающих на его счѐтный вход по переднему фронту им-

пульса. В случае, когда на вход Enable подается низкий уровень, 

счѐтчик прекращает насчѐт импульсов и хранит текущее значе-

ние. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно счѐтчик содержит вход Dir, который управ-

ляет направлением счѐта. 

Поведение Если на входе Dir удерживается низкий уровень сигнала, 

счѐтчик работает как суммирующий. 

Когда на входе Dir удерживается высокий уровень сигнала, 

счѐтчик работает как вычитающий. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно счѐтчик содержит вход данных Data[...], 

разрядность которого равна разрядности самого счѐтчика и вход 

загрузки данных Load. 

Поведение Если на входе Load удерживается высокий уровень, в счѐт-

чик загружается значение, установленное на входе Data[...] неза-

висимо от состояния входа Enable. 

Низкий уровень на входе Load никак не влияет на работу 

счѐтчика. 
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Задание №2 

 

Разработать поведенческое описание параллельного сумматора беззнако-

вых целых чисел. 

 

Таблица 3.2 – Задание №2 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Сумматор содержит асинхронный вход сброса Res, вход 

тактирования Clk, вход разрешения счѐта Enable, входы 

Operand1[...] и Operand2[...] слагаемых, выход результата 

Result[...], выход переноса Carryout. 

Разрядность входных операндов Operand1[...], Operand2[...] 

и выхода Result[...] сумматора задается как статический параметр, 

значение которого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходах сумматора устанавливается низкий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Enable удерживается вы-

сокий уровень сигнала, сумматор осуществляет сложение чисел, 

поступающих на его входы, по переднему фронту импульса так-

тирования Clk. В случае, когда на вход Enable подается низкий 

уровень, сумматор не производит сложение и хранит результат 

последней операции. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно сумматор содержит вход Check и выход Par-

ity контроля чѐтности вычисленного результата. 

Поведение Когда на входе Check удерживается низкий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов в полученном результате нечѐтно) либо низкий (если 

количество единиц чѐтно) уровень. 

Высокий уровень на входе Check никак не влияет на работу 

сумматора, а выход Parity в этом случае переводится в Z-

состояние. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно сумматор содержит выход сравнения опе-

рандов Equal[...], разрядностью 2. 

Поведение После выполнения операции сложения на этом выходе 

устанавливаются следующие значения: 

- 00, если оба входных операнда одинаковые; 

- 10, если значение на входе Operand1[...] больше; 

- 01, если значение на входе Operand2[...] больше; 
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Задание №3 

 

Разработать поведенческое описание параллельного вычитателя беззна-

ковых целых чисел. 

 

Таблица 3.3 – Задание №3 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Вычитатель содержит асинхронный вход сброса Res, вход 

тактирования Clk, вход разрешения счѐта Enable, входы уменьша-

емого Operand1[...] и вычитаемого Operand2[...], выход результата 

Result[...], выход заѐма Borrow. 

Разрядность входных операндов Operand1[...], Operand2[...] 

и выхода Result[...] вычитателя задаѐтся как статический пара-

метр, значение которого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходах вычитателя устанавливается низкий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Enable удерживается вы-

сокий уровень сигнала, вычитатель осуществляет вычитание чи-

сел, поступающих на его входы, по заднему фронту импульса 

тактирования Clk. В случае, когда на вход Enable подается низкий 

уровень, вычитатель не производит вычитание и хранит результат 

последней операции. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно вычитатель содержит вход Check и выход 

Parity контроля чѐтности вычисленного результата. 

Поведение Когда на входе Check удерживается высокий уровень, на 

выходе Parity устанавливается высокий (если количество единич-

ных разрядов в полученном результате нечѐтно) либо низкий (ес-

ли количество единиц чѐтно) уровень. 

Низкий уровень на входе Check никак не влияет на работу 

сумматора, а выход Parity в этом случае переводится в Z-

состояние. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно вычитатель содержит выход сравнения опе-

рандов Equal[...], разрядностью 2. 

Поведение После выполнения операции вычитания на этом выходе 

устанавливаются следующие значения: 

- 11, если оба входных операнда одинаковые; 

- 10, если значение на входе Operand1[...] меньше; 

- 01, если значение на входе Operand2[...] меньше; 
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Задание №4 

 

Разработать поведенческое описание цифрового компаратора беззнако-

вых целых чисел. 

 

Таблица 3.4 – Задание №4 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Компаратор содержит асинхронный вход сброса Res, вход 

тактирования Clk, вход разрешения сравнения Enable, входы опе-

рандов Operand1[...] и Operand2[...], выход условия равно Eq, вы-

ход условия первый больше Gr, выход условия первый 

меньше Le. 

Разрядность входных операндов Operand1[...] и Operand2[...] 

компаратора задаѐтся как статический параметр, значение кото-

рого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходах компаратора устанавливается низкий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Enable удерживается вы-

сокий уровень сигнала, компаратор осуществляет сравнение чи-

сел, поступающих на его входы, по переднему фронту импульса 

Clk. В результате сравнения на выходе, для которого выполни-

лось условие сравнения, устанавливается высокий уровень сигна-

ла. В случае, когда на вход Enable подается низкий уровень, все 

выходы компаратора переводятся в Z-состояние. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно компаратор содержит вход инверсии опе-

рандов Inv. 

Поведение Если на входе Inv удерживается высокий уровень сигнала, 

данные в компаратор поступают без инверсии. 

Когда же на входе Inv удерживается низкий уровень сигна-

ла, каждый бит данных инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно компаратор содержит выход анализа опе-

рандов Odd_Even[...], разрядностью 2. 

Поведение После выполнения операции сравнения на этом выходе 

устанавливаются следующие значения: 

- 00, если оба входных операнда чѐтные; 

- 11, если оба входных операнда нечѐтные; 

- 10, если значение на входе Operand1[...] нечѐтное; 

- 01, если значение на входе Operand2[...] нечѐтное; 
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Задание №5 

 

Разработать поведенческое описание цифрового компаратора беззнако-

вых целых чисел. 

 

Таблица 3.5 – Задание №5 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Компаратор содержит асинхронный вход сброса Res, вход 

тактирования Clk, вход разрешения сравнения Enable, входы опе-

рандов Operand1[...] и Operand2[...], выход условия не равно Neq, 

выход условия первое больше или равно Greq, выход условия 

первое меньше или равно Leeq. 

Разрядность входных операндов Operand1[...] и Operand2[...] 

компаратора задаѐтся как статический параметр, значение кото-

рого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходах компаратора устанавливается низкий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Enable удерживается вы-

сокий уровень сигнала, компаратор осуществляет сравнение чи-

сел, поступающих на его входы, по заднему фронту импульса Clk. 

В результате сравнения на выходе, для которого выполнилось 

условие сравнения, устанавливается высокий уровень сигнала. В 

случае, когда на вход Enable подается низкий уровень, все выхо-

ды компаратора переводятся в Z-состояние. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно компаратор содержит вход инверсии опе-

рандов Inv. 

Поведение Если на входе Inv удерживается низкий уровень сигнала, 

данные в компаратор поступают без инверсии. 

Когда же на входе Inv удерживается высокий уровень сиг-

нала, каждый бит данных инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно компаратор содержит выход анализа опе-

рандов Even_Odd[...], разрядностью 2. 

Поведение После выполнения операции сравнения на этом выходе 

устанавливаются следующие значения: 

- 00, если оба входных операнда чѐтные; 

- 11, если оба входных операнда нечѐтные; 

- 10, если значение на входе Operand1[...] нечѐтное; 

- 01, если значение на входе Operand2[...] нечѐтное; 
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Задание №6 

 

Разработать поведенческое описание параллельного регистра. 

 

Таблица 3.6 – Задание №6 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Регистр содержит асинхронный вход сброса Res, асинхрон-

ный вход установки Set, вход разрешения записи Wr, вход разре-

шения чтения Rd, вход данных Data[...], выход данных Result[...]. 

Разрядность входного Data[...] и выходного Result[...] сигна-

ла данных регистра задаѐтся как статический параметр, значение 

которого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе регистра устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе регистра устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

В случае, когда на входах Res и Set одновременно удержи-

вается низкий уровень, выход регистра переходит в Z-состояние. 

При условии, что на входах Res и Set удерживается высокий 

уровень сигнала, запись данных в регистр осуществляется по пе-

реднему фронту импульса на входе Wr. 

Если же на входах Res, Set и Rd удерживается высокий уро-

вень сигнала, осуществляется чтение данных из регистра. Если на 

входе Rd удерживается низкий уровень сигнала, и на каждом из 

выходов регистра устанавливается низкий уровень сигнала. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Inv, который инвер-

тирует каждый бит входных данных перед записью. 

Поведение Если на входе Inv удерживается высокий уровень сигнала, 

данные в регистр записываются без инверсии. 

Когда же на входе Inv удерживается низкий уровень сигна-

ла, каждый бит данных инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Check и выход Parity 

контроля чѐтности хранимых данных. 

Поведение Если на входе Check удерживается высокий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов для хранимых в регистре данных нечѐтно) либо низкий 

(если количество единиц чѐтно) уровень. 

Низкий уровень на входе Check никак не влияет на работу 

регистра, а выход Parity в этом случае переводится в Z-состояние. 

 



Методические указания 

 49 

Задание №7 

 

Разработать поведенческое описание преобразователя двоично-

десятичного кода в семисегментный. 

 

Таблица 3.7 – Задание №7 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Преобразователь содержит асинхронный вход сброса Res, 

вход разрешения преобразования Enable, вход загрузки данных 

Load, вход данных BinCode[...], выход 7SegCode[...]. 

Разрядность входного сигнала BinCode[...] задается как ста-

тический параметр, значение которого равно 4. 

Разрядность выходного сигнала 7SegCode[...] задается как 

статический параметр, значение которого равно 7. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе преобразователя устанавливается низкий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Enable удерживается вы-

сокий уровень сигнала, преобразователь осуществляет преобразо-

вание двоичного кода, поступающего на его вход данных по пе-

реднему фронту импульса тактирования Load. В случае, когда на 

вход Enable подается низкий уровень, все выходы преобразовате-

ля переводятся в Z-состояние. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно преобразователь содержит вход Inv, кото-

рый инвертирует каждый бит выходного кода. 

Поведение Если на входе Inv удерживается высокий уровень сигнала, 

выходной код устанавливается без инверсии. 

Когда же на входе Inv удерживается низкий уровень сигна-

ла, каждый бит выходного кода инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно преобразователь содержит вход Check и 

выход Parity контроля чѐтности семисегментного кода. 

Поведение Если на входе Check удерживается низкий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов в выходном коде нечѐтно) либо низкий (если количество 

единиц чѐтно) уровень. 

Высокий уровень на входе Check никак не влияет на работу 

преобразователя, а выход Parity в этом случае переводится в 

Z-состояние. 
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Задание №8 

 

Разработать поведенческое описание последовательного регистра. 

 

Таблица 3.8 – Задание №8 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Регистр содержит асинхронный вход сброса Res, асинхрон-

ный вход установки Set, вход разрешения записи Wr, вход разре-

шения чтения Rd, вход тактирования Clk, вход данных Data, вы-

ход данных Result. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе регистра устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе регистра устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

В случае, когда на входах Res и Set одновременно удержи-

вается низкий уровень, выход регистра переходит в Z-состояние. 

При условии, что на входах Res, Set и Wr удерживается вы-

сокий уровень сигнала, запись данных в регистр осуществляется 

по заднему фронту импульса на входе Clk. При этом, если на вхо-

де Wr удерживается низкий уровень, в регистр записывается 0. 

Если же на входах Res, Set и Rd удерживается высокий уро-

вень сигнала, осуществляется чтение данных из регистра. Если на 

входе Rd удерживается низкий уровень сигнала, на выходе реги-

стра устанавливается низкий уровень сигнала. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Inv, который инвер-

тирует каждый бит входных данных перед записью в регистр. 

Поведение Если на входе Inv удерживается низкий уровень сигнала, 

данные в регистр записываются без инверсии. 

Когда же на входе Inv удерживается высокий уровень сиг-

нала, каждый бит данных инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Check и выход Parity 

контроля чѐтности хранимых данных. 

Поведение Если на входе Check удерживается низкий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов для хранимых в регистре данных нечѐтно) либо низкий 

(если количество единиц чѐтно) уровень. 

Высокий уровень на входе Check никак не влияет на работу 

регистра, а выход Parity в этом случае переводится в Z-состояние. 
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Задание №9 

 

Разработать поведенческое описание преобразователя двоичного кода в 

код Грея. 

 

Таблица 3.9 – Задание №9 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Преобразователь содержит асинхронный вход установки 

Set, вход разрешения преобразования Enable, вход загрузки дан-

ных Load, вход данных BinCode[...], выход GreyCode[...]. 

Разрядность входного сигнала BinCode[...] и выходного 

GreyCode[...] задается как статический параметр, значение кото-

рого равно 5. 

Поведение Если на входе Set удерживается низкий уровень сигнала, на 

выходе преобразователя устанавливается высокий уровень сигна-

ла (независимо от состояния остальных входов). 

При условии, что на входах Set и Enable удерживается вы-

сокий уровень сигнала, преобразователь осуществляет преобразо-

вание двоичного кода, поступающего на его вход данных по зад-

нему фронту импульса тактирования Load. В случае, когда на 

вход Enable подается низкий уровень, все выходы преобразовате-

ля переводятся в Z-состояние. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Преобразователь должен дополнительно содержать вход 

Inv, который инвертирует каждый бит выходного кода. 

Поведение Если на входе Inv удерживается высокий уровень сигнала, 

выходной код устанавливается без инверсии. 

Когда же на входе Inv удерживается низкий уровень сигна-

ла, каждый бит выходного кода инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно преобразователь содержит вход Check и 

выход Parity контроля чѐтности кода Грея. 

Поведение Если на входе Check удерживается низкий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов в выходном коде нечѐтно) либо низкий (если количество 

единиц чѐтно) уровень. 

Высокий уровень на входе Check никак не влияет на работу 

преобразователя, а выход Parity в этом случае переводится в 

Z-состояние. 
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Задание №10 

 

Разработать поведенческое описание делителя с произвольным постоян-

ным коэффициентом деления, построенного по методу принудительного зада-

ния коэффициента пересчета в вычитающем счѐтчике. 

 

Таблица 3.10 – Задание №10 

Уровень I (0 – 10 баллов) 

Интерфейс 

устройства 

Делитель содержит асинхронный вход сброса Res, асин-

хронный вход установки Set, счѐтный вход Clk, выход Dev. 

Значение коэффициента деления N задается как статиче-

ский параметр и должно быть не менее 11. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе делителя устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе делителя устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Set одновременно удер-

живается низкий уровень, выход делителя переходит в 

Z-состояние. 

В случае, когда на входах Res и Set удерживается высокий 

уровень сигнала, делитель осуществляет насчѐт импульсов, по-

ступающих на его счѐтный вход, по переднему фронту, формируя 

один импульс на выходе на каждые N входных импульсов. Дли-

тельность высокого уровня в сформированном импульсе состав-

ляет половину периода тактового сигнала. 

Уровень II (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно делитель содержит вход установки коэффи-

циента деления Koef[...], разрядность которого должна быть не 

менее 4, и вход загрузки коэффициента деления Load. 

Поведение Если на входе Load удерживается высокий уровень, в дели-

тель загружается значение коэффициента деления, получаемого 

со входа Koeff[...], при этом на выходе делителя удерживается 

низкий уровень сигнала и он не осуществляет насчѐт импульсов. 

Низкий уровень на входе Load никак не влияет на работу 

делителя. 
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Задание №11 

 

Разработать поведенческое описание делителя с произвольным постоян-

ным коэффициентом деления, построенного по методу исключения лишних со-

стояний. 

 

Таблица 3.11 – Задание №11 

Уровень I (0 – 10 баллов) 

Интерфейс 

устройства 

Делитель содержит асинхронный вход сброса Res, асин-

хронный вход установки Set, счѐтный вход Clk, выход Dev. 

Значение коэффициента деления N задается как статиче-

ский параметр и должно быть не менее 9. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе делителя устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе делителя устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Set одновременно удер-

живается низкий уровень, выход делителя переходит в 

Z-состояние. 

В случае, когда на входах Res и Set удерживается высокий 

уровень сигнала, делитель осуществляет насчѐт импульсов, по-

ступающих на его счѐтный вход, по переднему фронту, формируя 

один импульс на выходе на каждые N входных импульсов. Дли-

тельность высокого уровня в сформированном импульсе состав-

ляет половину периода тактового сигнала. 

Уровень II (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно делитель содержит вход установки коэффи-

циента деления Koef[...], разрядность которого должна быть не 

менее 4, и вход загрузки коэффициента деления Load. 

Поведение Если на входе Load удерживается низкий уровень, в дели-

тель загружается значение коэффициента деления, получаемого 

со входа Koeff[...], при этом на выходе делителя удерживается 

высокий уровень сигнала и он не осуществляет насчѐт импульсов. 

Высокий уровень на входе Load никак не влияет на работу 

делителя. 
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Задание №12 

 

Разработать поведенческое описание параллельно-последовательного ре-

гистра. 

 

Таблица 3.12 – Задание №12 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Регистр содержит асинхронные входы сброса Res и уста-

новки Set, входы разрешения записи Wr и чтения Rd, вход такти-

рования Clk, вход данных Data[...], выход данных Result. 

Разрядность входных данных Data[...] задаѐтся как статиче-

ский параметр, значение которого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе регистра устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе регистра устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

В случае, когда на входах Res и Set одновременно удержи-

вается низкий уровень, выход регистра переходит в Z-состояние. 

При условии, что на входах Res, Set и Wr удерживается вы-

сокий уровень сигнала, запись данных в регистр осуществляется 

по переднему фронту импульса на входе Clk. Если на входе Wr 

удерживается низкий уровень, в регистр записывается 0. 

Если же на входах Res, Set и Rd удерживается высокий уро-

вень сигнала, то осуществляется чтение данных из регистра. Если 

на входе Rd удерживается низкий уровень сигнала, на выходе ре-

гистра устанавливается низкий уровень сигнала. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Inv, который инвер-

тирует каждый бит входных данных перед записью. 

Поведение Если на входе Inv удерживается высокий уровень сигнала, 

данные в регистр записываются без инверсии. 

Когда же на входе Inv удерживается низкий уровень сигна-

ла, каждый бит данных инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Check и выход Parity 

контроля чѐтности хранимых данных. 

Поведение Если на входе Check удерживается высокий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов для хранимых в регистре данных нечѐтно) либо низкий 

(если количество единиц чѐтно) уровень. 

Низкий уровень на входе Check никак не влияет на работу 

регистра, а выход Parity в этом случае переводится в Z-состояние. 
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Задание №13 

 

Разработать поведенческое описание последовательно-параллельного ре-

гистра. 

 

Таблица 3.13 – Задание №13 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Регистр содержит асинхронные входы сброса Res и уста-

новки Set, вход разрешения записи Wr и чтения Rd, вход тактиро-

вания Clk, вход данных Data, выход данных Result[...]. 

Разрядность выходных данных Result[...] задаѐтся как ста-

тический параметр, значение которого должно быть не менее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе регистра устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе регистра устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

В случае, когда на входах Res и Set одновременно удержи-

вается низкий уровень, выход регистра переходит в Z-состояние. 

При условии, что на входах Res, Set и Wr удерживается вы-

сокий уровень сигнала, запись данных в регистр осуществляется 

по заднему фронту импульса на входе Clk. Если на входе Wr 

удерживается низкий уровень, в регистр записывается 0. 

Если же на входах Res, Set и Rd удерживается высокий уро-

вень сигнала, осуществляется чтение данных из регистра. Если на 

входе Rd удерживается низкий уровень сигнала, на выходе реги-

стра устанавливается низкий уровень сигнала. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Inv, который инвер-

тирует каждый бит входных данных перед записью. 

Поведение Если на входе Inv удерживается низкий уровень сигнала, 

данные в регистр записываются без инверсии. 

Когда же на входе Inv удерживается высокий уровень сиг-

нала, каждый бит данных инвертируется. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно регистр содержит вход Check и выход Parity 

контроля чѐтности хранимых данных. 

Поведение Если на входе Check удерживается низкий уровень, на вы-

ходе Parity устанавливается высокий (если количество единичных 

разрядов для хранимых в регистре данных нечѐтно) либо низкий 

(если количество единиц чѐтно) уровень. 

Высокий уровень на входе Check никак не влияет на работу 

регистра, а выход Parity в этом случае переводится в Z-состояние. 
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Задание №14 

 

Разработать поведенческое описание делителя с произвольным постоян-

ным коэффициентом деления, построенного по методу искусственного прину-

дительного насчѐта импульсов в счѐтчике. 

 

Таблица 3.14 – Задание №14 

Уровень I (0 – 10 баллов) 

Интерфейс 

устройства 

Делитель содержит асинхронный вход сброса Res, асин-

хронный вход установки Set, счѐтный вход Clk, выход Dev. 

Значение коэффициента деления N задается как статиче-

ский параметр и должно быть не менее 10. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе делителя устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе делителя устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

При условии, что Если на входах Res и Set одновременно 

удерживается низкий уровень, выход делителя переходит в 

Z-состояние. 

В случае, когда на входах Res и Set удерживается высокий 

уровень сигнала, делитель осуществляет насчѐт импульсов, по-

ступающих на его счѐтный вход, по заднему фронту, формируя 

один импульс на выходе на каждые N входных импульсов. Дли-

тельность высокого уровня в сформированном импульсе состав-

ляет половину периода тактового сигнала. 

Уровень II (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно делитель содержит вход установки коэффи-

циента деления Koeff[...], разрядность которого должна быть не 

менее 4, и вход загрузки коэффициента деления Load. 

Поведение Если на входе Load удерживается высокий уровень, в дели-

тель загружается значение коэффициента деления, получаемого 

со входа Koeff[...], при этом на выходе делителя удерживается 

низкий уровень сигнала и он не осуществляет насчѐт импульсов. 

Низкий уровень на входе Load никак не влияет на работу 

делителя. 
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Задание №15 

 

Разработать поведенческое описание оперативного запоминающего 

устройства. 

 

Таблица 3.15 – Задание №15 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

ОЗУ содержит шину адреса Addr[...], входную и выходную 

шины данных Data_in[...] и Data_out[...] соответственно, вход чте-

ния/записи данных Rd_Wr, вход тактирования Clk. 

Разрядность шины адреса Addr [...] задается как статиче-

ский параметр, значение которого не менее 5. Разрядность шины 

данных Data_in[...] и Data_out[...] задается как статический пара-

метр, значение которого не менее 8. 

Поведение Если на входе Rd_Wr удерживается высокий уровень сиг-

нала, запись данных, установленных на шине Data_in[...], осу-

ществляется по переднему фронту тактового импульса Clk в 

ячейку, адрес которой установлен на шине Addr[...]. 

В случае, когда на входе Rd_Wr удерживается низкий уро-

вень сигнала, чтение данных, установленных на шине 

Data_out[...], осуществляется по переднему фронту сигнала Clk из 

ячейки, адрес которой установлен на шине Addr[...]. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

ОЗУ дополнительно содержит асинхронный вход сброса 

Res и асинхронный вход установки Set. 

Поведение Если на входе Res удерживается низкий уровень сигнала, 

все биты всех ячеек ОЗУ принимают нулевое значение (незави-

симо от состояния остальных входов). 

Когда же на входе Set удерживается низкий уровень сигна-

ла, все биты всех ячеек ОЗУ принимают единичное значение 

(независимо от состояния остальных входов). 

При условии, что на входах Res и Set одновременно удер-

живается низкий уровень сигнала, содержимое ячеек ОЗУ не из-

меняется, а выход Data_out[...] переходит в Z-состояние. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

ОЗУ дополнительно содержит вход Inv, который инверти-

рует каждый бит входных данных перед записью. 

Поведение Если на входе Inv удерживается низкий уровень сигнала, 

данные записываются без инверсии. 

Когда же на входе Inv удерживается высокий уровень сиг-

нала, каждый бит входных данных инвертируется. 
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3.4 Пример выполнения расчѐтно-графической работы 

Ниже представлен пример выполнения расчѐтно-графической работы по 

дисциплине “Технологии проектирования компьютерных систем”, в котором 

разрабатывается синхронный счѐтчик с параллельным переносом. 

3.4.1 Анализ известных методов построения счѐтчиков 

Счѐтчики. Счетчиками называют последовательные устройства, предна-

значенные для подсчета и запоминания числа импульсов, поданных в опреде-

ленном временном интервале на его счетный вход. 

Классифицируют счетчики по направлению счета, по способу организа-

ции схемы переноса, по коэффициенту пересчета, по наличию синхронизации 

переключения счетчиков. 

По направлению счета: 

 а) суммирующие; 

 б) вычитающие; 

 в) реверсивные. 

По способу организации схемы переноса: 

 а) счетчики с последовательным переносом; 

 б) счетчики со сквозным переносом; 

 в) счетчики с параллельным переносом; 

 г) счетчики с комбинированным переносом. 

По коэффициенту пересчета: 

 а) двоичные; 

 б) двоично-десятичные; 

в) с произвольным постоянным коэффициентом пересчета; 

 г) с переменным коэффициентом счета и т.д. 

По наличию синхронизации переключения счетчиков: 

 а) асинхронные; 

 б) синхронные. 

Суммирующие счетчики. У этих счетчиков отсутствует общая для всех 

разрядов синхронизация, и переход разрядов в новые состояния происходит по-

следовательно разряд за разрядом, начиная от входного, на который поступают 

импульсы (смотри рисунок 3.1). 

 
Рисунок 3.1 – Асинхронный суммирующий счѐтчик с последовательным пере-

носом 
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Рисунок 3.2 – Временная диаграмма работы асинхронного суммирующего 

счѐтчика с последовательным переносом 

 

Из анализа рисунка 3.2 следует, что признаком  смены состояний любого 

из разрядов счетчика является переключение предыдущего разряда (или вход-

ного сигнала) из состояния “1” в “0”, причем старший разряд переключается в 

“1”, если все предыдущие разряды переключаются из “1” в “0”. 

Из временной диаграммы видно, что время установления счетчика t уст с.  

зависит от количества последовательно переключающихся разрядов и для N-

разрядного счетчика изменяется в пределах: 

t t N t tуст т уст с уст т уст. . . .max     (3.1) 

Максимальная частота следования импульсов fmax определяется пре-

дельной частотой подключения первого триггера. 

Если требуется дешифрировать каждое состояние счетчика, то до подачи 

очередного счетного импульса все разряды должны установиться в новое со-

стояние на время t 0 , где t 0  – время дешифрации состояний счетчика. В этом 

случае максимально допустимая частота смены состояний f c.max  определяется по 

наихудшему времени установления: 

f c.max= ( ).t N t уст т0

1      (3.2) 

Достоинства – минимальные затраты микросхем и минимум электриче-

ских связей. 

Главный недостаток – низкое быстродействие. 

Вычитающие счѐтчики. Вычитающий счетчик получается последова-

тельным соединением инверсных выходов предыдущих разрядов со счетными 

входами последующих разрядов T-триггера (смотри рисунок 3.3). 

 

 

 

 

 

 

 

 



Проектирование на VHDL в САПР Quartus II 

 60 

 
Рисунок 3.3 – Асинхронный вычитающий счѐтчик с последовательным перено-

сом 

 

T-триггеры переключаются отрицательными фронтами входного сигнала 

или сигнала с инверсного выхода предыдущего триггера, что соответствует по-

ложительному фронту (смотри рисунок 3.4). 

 
Рисунок 3.4 – Временная диаграмма работы асинхронного вычитающего счѐт-

чика с последовательным переносом 

 

На временных диаграммах переключение триггеров DD2 и DD3 синхро-

низировано положительными фронтами выходов Q1 и Q2. 

Таким образом, единственное отличие между суммирующими и вычита-

ющими счетчиками состоит в организации цепей переноса из младших разря-

дов в старшие.  

Все типы счетчиков могут быть использованы в цифровых устройствах 

“умеренного” быстродействия, когда частота следования синхроимпульсов не 

превышает критического  

Реверсивные счѐтчики. Реверсивный счетчик – это счетчик с управляе-

мым направлением счета (смотри рисунок 3.5). 
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Рисунок 3.5 – Асинхронный реверсивный счѐтчик 

 

Для построения реверсивного счетчика необходимо между разрядами 

включить логическую схему, обеспечивающую связь счетного входа второго и 

последующего триггеров с выходами Q (суммирование) или Q  (вычитание) 

предыдущих разрядов. 

Возможны различные реализации логических схем (смотри рисунок 3.6) 

между разрядами (E=0 – суммирование; E=1 – вычитание). 

 
Рисунок 3.6 – Логическая схема для построения реверсивного счѐтчика 

 

Включение дополнительных логических элементов между разрядами 

увеличивает время установления. 

Синхронные или параллельные счѐтчики. К синхронным или парал-

лельным относят счетчики, в которых переключение разрядов происходит од-

новременно, независимо от удаленности разряда от счетного входа. Это дости-

гается подачей на все триггеры синхронизирующих импульсов, которые поло-

жительным или отрицательным фронтом вызывают переключение триггеров. 

Благодаря этому достигается минимальное время установления счетчика t уст с. , 

которое не превышает время установления одного триггера t уст т.  Тем самым 

обеспечивается максимальная частота смены состояний счетчика: 

f
t t t tс

уст с уст т

.max

. .

1 1

0 0

    (3.3) 

Схема простейшего синхронного счетчика показана на рисунке 3.7 
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Рисунок 3.7 – Синхронный суммирующий счѐтчик со сквозным переносом 

 

Здесь сигнал переноса формируется последовательно по мере распро-

странения “1” через DD2, DD4, DD6 и т.д. Накопление задержки за счет этих 

вентилей обуславливает взаимное смещение счетных импульсов T и импульсов 

переноса. До тех пор, пока совпадение импульсов T и P
i
 не нарушается, счет-

чик работает без сбоев с максимально возможной частотой счета.  

Очевидно, для этого необходимо, чтобы выполнялось условие: 

( ) .р. рN t
f

t T tзд с

c

вх вх вх1
1

    (3.4) 

Ограничение сверху на N, либо на частоту f c  входных импульсов T, мо-

жет оказаться технически неприемлемым и обуславливает использование дру-

гих счетных вариантов счетчиков с дополнительными затратами ИМС. 

Принципиальной предпосылкой для построения синхронных счетчиков 

произвольной разрядности N является следующая закономерность: i-й разряд 

счетчика переключается синхроимпульсом в новое состояние, если все (i - 1) 

триггеры младших разрядов к моменту прихода синхроимпульса находятся в 

“1”. Сигнал, разрешающий переключение триггера i-го разряда в противопо-

ложное состояние, должен сформировать логический элемент, фиксирующий 

состояние “1” всех (i - 1) младших разрядов. 

С ростом номера разряда увеличивается количество входов логических 

элементов цепи переноса, поэтому соответственно с ростом количества разря-

дов N усложняется схема счетчика. 

3.4.2 Описание варианта задания 

Разработать поведенческое описание синхронного счѐтчика с параллель-

ным переносом. 
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Таблица 3.16 – Задание №16 

Уровень I (0 – 5 баллов) 

Интерфейс 

устройства 

Счѐтчик содержит асинхронный вход сброса Res, асинхрон-

ный вход установки Set, счѐтный вход Clk, вход разрешения счѐта 

Enable, выход Result [...]. 

Разрядность выходного сигнала Result [...] счѐтчика задается 

как статический параметр, значение которого должно быть не ме-

нее 4. 

Поведение Если на входе Res удерживается низкий уровень сигнала, на 

выходе счѐтчика устанавливается низкий уровень сигнала (неза-

висимо от состояния остальных входов). 

Когда на входе Set удерживается низкий уровень сигнала, 

на выходе счѐтчика устанавливается высокий уровень сигнала 

(независимо от состояния остальных входов). 

Если же на входах Res и Set одновременно удерживается 

низкий уровень, выход счѐтчика переходит в Z-состояние. 

При условии, что на входах Res, Set, Enable удерживается 

высокий уровень сигнала, счѐтчик осуществляет насчѐт импуль-

сов, поступающих на его счѐтный вход по заднему фронту им-

пульса. В случае, когда на вход Enable подается низкий уровень, 

счѐтчик прекращает насчѐт импульсов и хранит своѐ текущее зна-

чение. 

Уровень II (5 – 10 баллов) 

Интерфейс 

устройства 

Счѐтчик должен дополнительно содержать вход Dir, кото-

рый управляет направлением счѐта. 

Поведение Если на входе Dir удерживается высокий уровень сигнала, 

счѐтчик работает как вычитающий. 

Когда же на входе Dir удерживается низкий уровень сигна-

ла, счѐтчик работает как суммирующий. 

Уровень III (10 – 15 баллов) 

Интерфейс 

устройства 

Дополнительно счѐтчик содержит вход данных Data [...], 

разрядность которого равна разрядности самого счѐтчика, вход 

загрузки данных Load. 

Поведение Если на входе Load удерживается высокий уровень, в счѐт-

чик загружается значение, установленное на входе Data [...] неза-

висимо от состояния входа Enable. 

Низкий уровень на входе Load никак не влияет на работу 

счѐтчика. 

3.4.3 Разработка схемы алгоритма функционирования синхронного 

реверсивного счѐтчика с параллельным переносом 

Исходя из анализа известных методов построения и функционирования 

счѐтчиков, с учѐтом всех требований задания, можно предложить следующую 

схему алгоритма функционирования (смотри рисунок 3.8). 
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Поведение заданного синхронного счѐтчика возможно описать при по-

мощи единственного предложения PROCESS, в список чувствительности кото-

рого следует указать 3 внешних сигнала – Res, Set, Clk. 

Ввиду особенностей описания и использования сигналов в языке VHDL 

при описании заданного устройства удобно использовать вспомогательный 

внутренний сигнал sresault. Таким образом, внутри предложения PROCESS по-

является возможность осуществлять необходимые изменения и действия с ука-

занным вспомогательным сигналом, а состояние выходов самого счѐтчика из-

менять по окончанию выполнения процесса. Для осуществления необходимых 

действий следует также объявить вспомогательную переменную buf. 

По условию задания входы Res и Set счѐтчика являются асинхронными. 

Это означает, что сигналы на этих входах напрямую влияют на работу устрой-

ства, не зависимо от сигналов на остальных входах. Поэтому, они должны ана-

лизироваться в первую очередь. Причѐм, случай, когда на каждом из этих вхо-

дов удерживается уровень логического '0' должен анализироваться самым пер-

вым, в противном случае – выходы счѐтчика не всегда смогут переключаться в 

Z-состояние. 

Если ни на одном из асинхронных входов счѐтчика не удерживается ак-

тивный уровень сигнала, работа счѐтчика определяется по сигналу на входе 

тактирования Clk. По условию задания, счѐтчик может изменить своѐ состояние 

по переднему фронту импульса на этом входе. 

После поступления тактового импульса следует проанализировать состо-

яние входа загрузки данных load. Если на нѐм удерживается уровень логиче-

ской '1', то происходит загрузка данных в счѐтчик – выходное состояние счѐт-

чик становится равным состоянию, заданному на входах Data[...], в противном 

случае происходит насчѐт импульсов. 

Возможность осуществлять насчѐт поступивших импульсов определяется 

уровнем сигнала на входе enable. Если на нѐм удерживается низкий уровень 

сигнала, то счѐтчик переходит в режим хранения, т.е. не изменяет своего состо-

яния. В противном случае – выходное состояние счѐтчика может изменится в 

соответствии с состоянием на входе Dir. 

Если на входе Dir удерживается уровень логической '1', то счѐтчик рабо-

тает как вычитающий, т.е. значение на его выходах декрементируется. В про-

тивном случае – происходит инкремент выходного значения счѐтчика. 

Перед окончанием выполнения процесса, следует присвоить выходам 

счѐтчика новое состояние, значение которого определяется вспомогательным 

сигналом. 
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Рисунок 3.8 – Схема алгоритма функционирования устройства 

3.4.4 Разработка поведенческого описания синхронного реверсивного 

счѐтчика с параллельным переносом на языке VHDL 

LIBRARY ieee; --подключение библиотеки ieee 

USE ieee.std_logic_1164.all; --подключение пакетов этой библиотеки 

USE ieee.std_logic_arith.all; 

USE ieee.std_logic_unsigned.all; 

 

ENTITY count IS 

GENERIC (width: INTEGER:= 4);  

PORT ( 

 data: IN STD_LOGIC_VECTOR (0 TO width-1);  --вход данных 

 load: IN BIT; --вход загрузки 
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 clk: IN BIT; --вход синхронизации 

 res: IN BIT; --асинхронный сброс 

 enable: IN BIT; --вход разрешения счета 

 set: IN BIT; --асинхронная установка 

 dir: IN BIT; --вход задания направление счѐта 

 result: OUT STD_LOGIC_VECTOR (0 TO width-1)); --выходы 

END count; 

 

ARCHITECTURE arc_counter OF count IS 

SIGNAL sresault: STD_LOGIC_VECTOR (0 TO width-1); 

--сигнал для хранения результата 

BEGIN 

 

PROCESS (clk, res, set) 

VARIABLE buf: INTEGER; --буферная переменная 

BEGIN 

  IF(res= '0' AND set= '0') THEN 

  sresault<= (0 TO width-1=> 'Z'); --Z-состояние на выходе 

 ELSIF(res= '0') THEN 

  sresault<= (0 TO width-1=> '0'); 

--если на асинхронном входе Res удерживается низкий уровень сигнала, 

--то на выходе счѐтчика устанавливается низкий уровень сигнала 

 ELSIF(set= '0') THEN 

  sresault<= (0 TO width-1=> '1'); 

--если на асинхронном входе Set удерживается низкий уровень сигнала, 

--то на выходе счѐтчика устанавливается высокий уровень сигнала  

 ELSIF (clk'EVENT AND clk= '1') THEN 

--если пришѐл передний фронт синхроимпульса 

  IF(load= '1') THEN 

   sresault<= data; 

--если на входе Load удерживается высокий уровень, то в счѐтчик 

--загружается значение, установленное на входе Data 

  ELSIF(enable= '0') THEN 

   sresault<= sresault; 

--если на входе enable удерживается низкий уровень, то счѐтчик 

--прекращает насчѐт импульсов и хранит своѐ текущее значение 

  ELSIF(dir= '0') THEN 

--если на входе Dir удерживается высокий уровень сигнала, 

--то счѐтчик работает как суммирующий 

   buf:= CONV_INTEGER(sresault)+ 1; 

   sresault<= CONV_STD_LOGIC_VECTOR(buf, width); 

  ELSE 

--в противном случае счѐтчик работает как вычитающий 

   buf:= CONV_INTEGER(sresault)- 1; 

   sresault<= CONV_STD_LOGIC_VECTOR(buf, width); 
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  END IF; 

 END IF; 

 result<= sresault; --изменение выходного состояния счѐтчика 

END PROCESS; 

 

END arc_counter; 

3.4.5 Анализ работоспособности синхронного реверсивного счѐтчика 

с параллельным переносом и оценка соответствия заданным 

требованиям 

Если на входе Res удерживается низкий уровень сигнала, на выходе счѐт-

чика устанавливается низкий уровень сигнала независимо от состояния осталь-

ных входов (смотри рисунок 3.9). 

 

 
Рисунок 3.9 – На входе Res установлен низкий уровень сигнала 

 

Когда на входе Set удерживается низкий уровень сигнала, на выходе 

счѐтчика устанавливается высокий уровень сигнала независимо от состояния 

остальных входов (смотри рисунок 3.10). 

 

 
Рисунок 3.10 – На входе Set установлен низкий уровень сигнала 

 

Если же на входах Res и Set одновременно удерживается низкий уровень 

сигнала, выход счѐтчика переходит в Z-состояние (смотри рисунок 3.11). 
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Рисунок 3.11 – На входах Set и Res установлен низкий уровень сигнала 

 

При условии, что на входах Res, Set, Enable удерживается высокий уро-

вень сигнала, счѐтчик осуществляет насчѐт импульсов, поступающих на его 

счѐтный вход по заднему фронту импульса (смотри рисунок 3.12).  

 

 
Рисунок 3.12 – На входах Res, Set, Enable удерживается высокий уровень сиг-

нала 

 

В случае, когда на вход Enable подается низкий уровень, счѐтчик прекра-

щает насчѐт импульсов и хранит своѐ текущее значение (смотри рисунок 3.13). 

 

 
Рисунок 3.13 – На входе Enable удерживается низкий уровень сигнала 

 

Если на входе Dir удерживается высокий уровень сигнала, счѐтчик рабо-

тает как вычитающий (смотри рисунок 3.14). 
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Рисунок 3.14 – На входе dir удерживается высокий уровень сигнала 

 

Когда же на входе Dir удерживается низкий уровень сигнала, счѐтчик ра-

ботает как суммирующий (смотри рисунок 3.15). 

 

 
Рисунок 3.15 – На входе dir удерживается низкий уровень сигнала 

 

Если на входе Load удерживается высокий уровень, в счѐтчик загружает-

ся значение, установленное на входе Data [...] независимо от состояния входа 

Enable. Низкий уровень на входе Load никак не влияет на работу счѐтчика 

(смотри рисунок 3.16). 

 

 
Рисунок 3.16 – На входе Load удерживается высокий и низкий уровень 

 

Как видно из анализа полученных временных диаграмм, разработанный 

на языке VHDL синхронный реверсивный счѐтчик с параллельным переносом 

соответствует всем требованиям, каждого из трѐх уровней задания. 

3.4.6 Выводы 

В ходе выполнения расчетно-графической работы был проведен теорети-

ческий анализ существующих методов построения синхронных счѐтчиков. 
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Синхронные счѐтчики – это счѐтчики, в которых переключение разрядов про-

исходит одновременно, независимо от удаленности разряда от счетного входа. 

По заданию на расчетно-графическую работу было разработано поведен-

ческое описание синхронного счетчика с параллельным переносом на языке 

VHDL. В ходе создания синхронного счетчика с параллельным переносом были 

использования следующие синтаксические конструкции языка VHDL: 

– If Statement – позволяет осуществлять выбор предложения (или группы 

последовательных предложений) для выполнения на основании результатов 

проверки выполнения указанных условий; 

– Process Statement – это параллельное предложение языка, в котором на 

основе множества последовательных предложений описывается поведение все-

го устройства или некоторой его части; 

– Variable Declaration Statement – используется для декларации перемен-

ных внутри тела процесса; 

– Signаl Declaration Statement – используется для описания внутренних 

сигналов устройства, которые не видимы из внешнего мира и являются частью 

внутренней архитектуры системы и предназначены для обеспечения связи 

между внутренними узлами и устройствами. 

Разработанный синхронный счѐтчик с параллельным переносом в даль-

нейшем может быть использован, как библиотечное устройство. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Методические указания 

 71 

РЕКОМЕНДОВАННАЯ ЛИТЕРАТУРА 

1 Антонов А.П. Язык описания цифровых устройств АltеrаHDL. Практи-

ческий курс. – М.: ИП РадиоСофт, 2001. – 224 с. 

2 Бибило П.Н. Основы языка VHDL. – Москва: Солон-Р, 2000.  

– 205 с. 

3 Казеннов Г.Г. Основы проектирования интегральных схем и систем. – 

М.: БИНОМ. Лаборатория знаний, 2005. – 295с. 

4 Комолов Д.А. Мяльк Р.А., Зобенко А.А., Филоппов А.С. Системы авто-

матизированного проектирования фирмы Altera MAX+plus II и Quartus II. Крат-

кое описание самоучитель. – М.: ИП РадиоСофт, 2002. – 352с.: ил. 

5 Соловьев В.В. Проектирование цифровых систем на основе программи-

руемых логических интегральных схем. 2-е изд., стереотип. – М.: Горячая ли-

ния – Телеком, 2007. – 636 с. 

6 Стешенко В.Б. ПЛИС фирмы ALTERA: проектирование устройств об-

работки сигналов. - М.: Додека, 2000. - 127 с. 

7 Стешенко В.Б. ПЛИС фирмы Altera: элементная база, система проекти-

рования и языки описания аппаратуры. – М.: Издательский дом «Додэка ХХI», 

2002. – 576 с. 

8 Суворова Е. А., Шейнин Ю. Е. Проектирование цифровых систем на 

VHDL. – СПб.: БХИ-Петербург, 2003, - 576 с. 

9 Яицков А.С. VHDL – язык описания аппаратных средств. – М.: Латмэс, 

1998. – 119 с. 

10 IEEE Std 1076-2000 // IEEE Standard VHDL. Language Reference Manu-

al. – New York: IEEE, 2000/ - 290 c. 

11 Introduction to the Quartus II Software. – San Jose: Altera Corporation, 

2009. – 229 c. 

12 Quartus II Handbook Version 9.0. – San Jose: Altera Corporation, 2009. – 

2490 c. 


